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Before you begin  

During this lab, you can choose to learn about the FactoryTalk® View Studio for Machine Edition (ME) 
skills that are needed to create FactoryTalk View Machine Edition applications.  By using an empty 
project, you will learn how to add application content and configure communications to create a working 
system that can both read and write information from a Logix controller.  Basic alarming functions are also 
covered. 

You will review some of the more advanced capabilities and new functionality in FactoryTalk View ME 
v6.0 and have an opportunity to explore the features of FactoryTalk View ME within FactoryTalk® 
ViewPoint, our “thin client,” or browser-based, HMI solution.  FactoryTalk ViewPoint ME is used to publish 
web applications for FactoryTalk View ME projects that run on PanelView™ Plus terminals. 

Lastly, a set of optional topics are available where you can pick and choose which FactoryTalk View ME 
features you wish to work with and learn more about.  

All chapters take advantage of the new PanelView Plus 6 terminals that are located at each workstation. 

About this lab  

Chapter 1 is a demonstration of features for both hardware and software.  Using a paint shop application 
developed in FactoryTalk View ME v6.0, you will see firsthand how features like global objects, the recipe 
ActiveX control, a PDF file viewer, a FTP server and more can improve maintenance and runtime 
productivity. 

Chapter 2 is for new users and provides a basic overview of FactoryTalk View ME.  This chapter can be 
skipped for those who have a general working knowledge of the product.   

Chapter 3 expands your FactoryTalk View ME knowledge and explores what new features are available 
in the v6.0 release. 

Chapters 4 and 5 will take you through the basic and advanced features of FactoryTalk ViewPoint ME 
including what new features are available with the v1.2 release. 

Chapter 6 allows you to pick and choose any section, in any order, to cater to the areas of FactoryTalk 
View ME you would like to concentrate on. 

This lab takes approximately 2 hours to complete. 

Tools & prerequisites 

Hardware 

This hands-on lab does not require a Logix5000 controller however it could be used in place of SoftLogix 
5800. 

A PanelView Plus 6 terminal is required.   
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Software 

To complete this lab you must use the following hardware and software:  

� A Microsoft Windows XP SP3 computer 

� A Microsoft Windows® CE 6.0-based PanelView Plus 6 terminal. 

� Ethernet connection between computer and PanelView Plus 6 terminal 

� FactoryTalk View Machine Edition Studio v6.00 (CPR9 SR3) 

� FactoryTalk ViewPoint ME v1.20 (CPR9 SR3) 

� FactoryTalk Services Platform 2.30 (CPR9 SR3) 

� RSLinx Enterprise v5.30 (CPR9 SR3) 

� RSLinx Classic Lite v2.57 (CPR9 SR3) 

� RSLogix 5000 v18.00 

� SoftLogix 5800 v18.00 

Document conventions 

Throughout this workbook, we have used the following conventions to help guide you through the lab 
materials. 

This style or symbol: Indicates: 

Words shown in bold italics  
(e.g., RSLogix 5000  or OK) 

Any item or button that you must select, click on, or a 
menu name from which you must choose an option or 
command.  This will be an actual name of an item that you 
see on your screen or in an example. 

Words shown bolded, 
underlined and enclosed in 
single quotes  
(e.g., 'Controller1 ') 

An entry that you must type in the specified field.  This is 
information that you must supply based on your application 
(e.g., a variable). 

Note:   When you type the text in the field, remember that 
you do not need to type the quotes; simply type the words 
that are contained within them (e.g., Controller1). 

This is sample text. 

 

Text that appears inside of a gray box is supplemental 
information regarding the lab materials or learning goals; 
the information is not required for you to complete the lab 
exercises.  The supplemental text may provide you with 
helpful hints that can make it easier for you to use this 
product.. 

 

This icon denotes new FactoryTalk View Machine Edition 
v6.0 or new FactoryTalk ViewPoint ME v1.2 functionality. 

Note:   If the mouse button is not specified in the text, you should click on the left mouse button. 
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FactoryTalk® View Machine Edition 

FactoryTalk® View Machine Edition (ME) is a machine-level HMI product that supports both open and 
dedicated operator interface solutions for monitoring and controlling individual machines or small 
processes.  It provides a consistent operator interface across multiple platforms, including Microsoft® 
Windows® CE and 32-bit Microsoft® Windows® 7, XP, Vista solutions. 

FactoryTalk View Machine Edition contains two components: 

� FactoryTalk View® Studio  - This is the development environment containing the tools you need for 
creating all aspects of a human-machine interface (HMI), including graphic displays, trends, alarm 
reporting and real-time animation.  It also provides tools for testing individual displays and entire 
applications.   When development is completed, a run-time (.MER) file created to run on a PanelView 
Plus or personal computer. 

� FactoryTalk View® Machine Edition Station  - This is the run-time environment.  FactoryTalk View 
Machine Edition Station executes the run-time (.MER file) application.   FactoryTalk View Machine 
Edition Station is embedded in PanelView Plus terminals.   Run-time applications may also be 
executed on a personal computer.  Executing run-time applications on a personal computer requires 
additional software licenses. 

 PanelView™ Plus 6 
 

The PanelView Plus operator interface terminals are designed to optimize system development, 
performance, and efficiency.  The PanelView Plus 6 line is the latest addition to Rockwell Automation’s 
versatile family of Allen-Bradley PanelView operator interface displays for machine level operator terminal 
applications in industrial environments. 

Enhancements to the hardware platform, embedded operating system and development environment 
enable users to: 

� Take time and costs out of application development - PanelView Plus 6 dramatically reduces 
development, setup time and troubleshooting time through features like tag re-use, complete Symbol 
Factory graphic library and pre-built face plates. 

� Run their processes more effectively - Improved hardware performance delivers up 30% faster  
screen response, enabling operators to navigate through screens more quickly, and can help avoid 
maintenance calls resulting from mistakenly pressing inputs multiple times. In addition, new 
capabilities wring more value from your process. 

� Reduce maintenance costs - New features like on-board pdf capability and remote user access 
enable context-sensitive help and can avoid on-site visits to get processes back up and running faster 
when things go wrong. 
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FactoryTalk® ViewPoint 

FactoryTalk® ViewPoint is an add-on to FactoryTalk View ME running on PanelView Plus that provides 
for a fully scalable, fully animated, read-only view of existing applications from a Web browser. 

To make information about your plant or process available on demand from a Web browser in your office, 
home, or hotel, all you have to do is select the FactoryTalk View graphic displays you want to make ready 
for the Web, and then publish the displays to the FactoryTalk ViewPoint Server which runs on a 
PanelView Plus. 

There is no installation of any Rockwell Software products on the browser computer: all you need to 
connect to a published FactoryTalk ViewPoint Web application is the name (or IP address) of the 
PanelView Plus hosting the FactoryTalk ViewPoint Server that stores the application. 

Once you enter a simple address directly into your Web browser using the name or IP address, the 
browser will connect to the published web application and open the initial display selected. Use navigation 
buttons in the application to view other published displays, or use the web browser's navigation tools. 

Displays in a FactoryTalk ViewPoint application are read-only. Graphic objects in the displays are fully 
animated; however, you cannot use the objects to write to tags or to start and stop HMI components. For 
example, a numeric input object with a tag connection will display the tag's current value, but will not 
permit downloads. 
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Chapter 1: Demo 

Completing this section requires approximately 10 minutes. 

This chapter simulates an automotive paint shop application to provide a quick look at features offered by 
FactoryTalk View ME v6.0 and the new PanelView Plus 6 terminals. 

The Demo will quickly showcase the following features on the PanelView Plus terminal: 

� Global Objects with Parameter Passing 

� Recipe ActiveX with FTP Server Data Storage 

� HMI Faceplates and PDF Viewer 

� Retrieving Data logs using the FTP Server 

� Symbol Factory Library 

� FactoryTalk ViewPoint  

As you navigate through the application, you will get a sense of a machine operator‘s typical day with 
focus on Runtime Productivity and Maintenance Productivity. 

Load the Demo application on the PanelView Plus Ter minal 

Execute the following steps to run the PVP6_Demo.MER application required for the demonstration. 

1. If FactoryTalk View ME Station is not already running on the PanelView Plus terminal, double-tap the 

FTView ME Station  icon on the desktop.  

2. Press the Load Application [F1]  button. 

 

3. Select the PVP6_Demo.MER  file from those available from the terminal’s Internal Storage. 

4. Press Load [F2]  to load the runtime file in to memory. 

5. When prompted, press Yes [F7]  to overwrite the terminal’s current communication configuration with 
the configuration contained within the PVP6_Demo.MER  file. 

6. Once successfully loaded, press the Run Application [F2]  to start executing the runtime file. 
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While the terminal is starting the application, an update dialog is displayed. 

 

After the start-up processing completes you should see your applications startup display. 

 

Global Objects with Parameter Passing 

Global objects save development time by linking the appearance and behavior of a base graphic object to 
multiple references of the object throughout an application.  Using parameter passing with Global objects 
lets you define a unique data source for each reference and still make changes to other aspects of the 
global object. 

1. Press on Cell #0  to open the paint cell display for the first cell. 

Each of the available cells represents an instance where a Global Object uses specified parameters 
to pass into a display. 

Global Object  Display 

 

 

 

 

 

 

Cell #0  
Parameters 

Passed 
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Data for 4 different cells can be viewed however; only one Global Object  and one graphic display  
needed to be developed to provide this data. 

3. Close the display by selecting the X  button. 

4. Repeat steps 2 and 3 for each of Cell #1 , Cell #2  and Cell #3  to note how responsive display 
switching can be on the new terminals. 

Recipe ActiveX with FTP Server Data Storage 

The Recipe ActiveX allows a user to remotely control recipe functions from the controller, via tags and 
read and write recipes to CSV files.  These recipes can be managed over the network using the FTP 
Server.  We will explore these features during the next section. 

Creating a new Recipe file  

1. Press again on Cell #0  to open the display. 

2. Select Recipe  . 

3. Use the arrow  button  to scroll down to the YELLOW  recipe and Enter   to 
display its values. 

  
 

The values for the Yellow  recipe are displayed under the Recipe Value  column and are maintained 
in a recipe file.  The values from Current Value  column represent the values that are currently in the 
controller.   
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4. Select Enter New Recipe Name   to create a new recipe file. 

5. With the on-screen keyboard, type in ‘Black ’ and press Enter . 

 

6. Press the Flow Rate Value  to enter a new setting. 

 

7. Enter the value of ‘20’ and press Enter  . 

8. Press the Pressure Value  to enter a new setting. 

 

9. Enter the value of ‘50’ and press Enter  . 

10. Press the Paint Color Value  to enter a new description. 
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11. Enter the name of ‘Black ’ and press Enter . 

 

Your recipe values should now look like this: 

 

12. Press on Save  and notice that the new recipe has been added. 

 

13. Now that a new recipe file has been created, push Download to Controller    to send 
the newly entered values to the controller.  You will see that the Current Value  data has been 
updated and now matches the Recipe Value  column. 
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Use a new Recipe file 

1. Press Overview  to return to the Paint Cell #0  display. 

 

The new recipe values are also displayed on this graphic. 

2. Press Start  to begin painting, as circled above.  Animation is used to give the operator indication that 
painting is in process.  

 

3. Press Stop  to end painting. 

In order to continue, an authorized user must log in to restart the painting cycle.   

4. Press on the lock  button , then Login . 
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The Login  display is opened.  Press the User (F2)  button and use the keyboard to enter 
‘ENGINEER’. Leave the Password (F3)  field blank. It should look like this:  

 

5. Press Enter  to complete the login process. 

6. Close the Login display by selecting the X  button. 

7. The Reset  button is now visible since our Engineer  user has the proper permissions.  Click on Reset  

. 

8. Press on the lock  button , then Logout .  Close the Login display by selecting the X  
button. 

9. Close the Paint Cell #0 display by selecting the X  button. 

10. Cell #0  is now indicating that it is painting the vehicles Black. 
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Transfer recipe files over network to FTP Server 

Turn to your desktop computer to start this next section.  You will be connecting to the PanelView Plus 
terminals using Internet Explorer to explore how recipe files can be transferred over a network. 

1. Launch Internet Explorer from the desktop icon and enter the following address: ftp://192.168.1.20   
where 192.168.1.20 is the IP address of your PanelView Plus and you are using the ftp:// syntax. 

 

Your window is now updated to show you the files from the PanelView Plus terminal. 

 

2. Click on My Documents then the Recipe  folder. 
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3. All the recipes files, including the new Black recipe, are available on the PanelView Plus FTP Server.  

 

4. The FTP Server can be used to transfer files over the network to and from your terminal when viewed 
within Windows Explorer.  Click on Page in the upper right hand corner, then Open FTP Site in 
Windows Explorer  to see the new view. 
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HMI Faceplates and PDF Viewer  

Faceplates are pre-built visualization components, designed to save time and provide easier integration 
with Integrated Architecture-based motion, drives, and process control such as Logix I/O, Control 
Devices, Networks, and Process Applications. 

In this next section we will manually trigger a fault and quickly obtain system diagnostics, use the PDF 
viewer to launch an instruction guide on how to handle faults, control a PowerFlex drive and see its 
diagnostics using the Logix I/O and Device faceplates and the new PDF Viewer utility.  

Turn once again to your PanelView Plus  terminal and return to the Main  display if the application does 
not already have this open. 

Logix I/O and Device Faceplates plus the PDF Viewer  

1. Press on Cell #0  to open the paint cell display and select Maintenance  . 

2. Press the DC Out  module to launch its Logix I/O faceplate. 

 

 

Now we will manually trigger a fault. 
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3. Press the I/O Fault Trigger  button  and notice that the faceplate is updated with the 
fault. 

 

4. In order to get information on troubleshooting the fault, we will launch an Instruction Guide using the 

PDF Viewer.  Press the Instruction Guide (PDF Viewer)  button . 

 

5. Close the Troubleshooting document by selecting the X  button. 
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6. Press the I/O Fault Clear  button  to clear the fault condition and verify that the faceplate 
has been updated. 

 

7. Close the I/O Module Faceplate by selecting the X  button. 

8. Now press the PowerFlex object to launch its faceplate. 

 

 

We will once again manually trigger a fault. 
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9. Press the Drive Fault Trigger  button  and notice that the faceplate is updated with the 
fault. 

 

10. In order to get information on troubleshooting the PowerFlex fault, we will again launch the Instruction 

Guide using the PDF Viewer.  Press the Instruction Guide (PDF Viewer)  button . 

 

This time the file was configured to open to a predefined bookmark. 
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11. Close the Troubleshooting document by selecting the X  button. 

12. Press the Drive Fault Clear  button  to clear the fault condition and verify that the 
faceplate has been updated. 

 

Control a Device using a Faceplate 

1. Press the Drive Speed  field to enter a new value.  
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2. Enter a value of ‘8000’ and press Enter . 

 

3. Press Start  to control the PowerFlex  drive. 

 

The faceplate automatically updates as the drive ramps up to reflect the new drive speed. 

 

4. Close the PowerFlex Faceplate  by selecting the X  button. 

5. Return to the Main display. 
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Retrieving Data logs using the FTP Server  

Turn to your desktop computer  to start this next section.  You will be connecting to the PanelView Plus 
terminals using Internet Explorer to explore how data log files can be managed over a network using the 
FTP Server. 

1. If Internet Explorer is not already open from a previous section, launch it using the desktop icon and 
enter the following address: ftp://192.168.1.20   where 192.168.1.20 is the IP address of your 
PanelView Plus and you are using the ftp:// syntax. 

 

Your window is now updated to show you the files from the PanelView Plus terminal. 

 

2. Click on My Documents then the Datalogs  folder. 
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The date and time stamp indicate that there has been no data log activity for a period of time.  This is 
because there is currently no data log model running that is logging to this location.  We will now go 
start one. 

 

3. Turn to your PanelView Plus  terminal and press the Start Datalog button .   

4. Press the Stop Datalog button . 

5. Return to your Internet Explorer window on your desktop computer  and click on View > Refresh . 

 

A datalog file is now available on the PanelView Plus FTP Server. The FTP Server can be used to 
transfer files over the network to and from your terminal when viewed within Windows Explorer. 
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Symbol Factory Library 

Symbol Factory is a new graphics library interface that can be launched from FactoryTalk View Studio 
v6.0. It is built on Software Toolbox’s Symbol Factory, and contains over 5,000 graphical objects.  

In this section you have the opportunity to browse through various categories to see what objects are 
available. 

1.  Press the Symbol Factory Objects button . 

2. Explore the different Symbol Factory objects available by pressing  each of the available category 
buttons. 

 

3. Press Back  to return to the above display when finished with each category. 

FactoryTalk ViewPoint 

FactoryTalk ViewPoint supports fully scalable and animated Web displays of PanelView Plus applications 
from the office, home, or on the road via an Internet browser.  This section will quickly show how to 
remotely connect to an application that is running on your PanelView Plus with published displays 
available for a FactoryTalk ViewPoint client. 
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1. Launch Internet Explorer from the desktop icon and enter the following address: 
http://192.168.1.20/FTVP   where 192.168.1.20 is the IP address of your PanelView Plus. 
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Chapter 2: FactoryTalk View Machine Edition - 

Beginner 

Completing this section requires approximately 20 minutes. 

In this section you will learn how to create a ‘Hello World’ application by: 

� Launching FactoryTalk View Studio for Machine Edition 

� Creating a new project, configure project settings, and add content to the project 

� Running the project on a PanelView Plus terminal 

When you have successfully completed this section, you will be able to interact with a running application 
on a PanelView Plus terminal. 

Creating a FactoryTalk ME Application 

1. Using the Start menu select All Programs >Rockwell Software >FactoryTalk View >  FactoryTalk 
View Studio  item. 

 

After FactoryTalk View Studio for Machine Edition opens you will see the following:  
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Exploring FactoryTalk View Studio for Machine Editi on Interface 
The FactoryTalk View Studio for Machine Edition Application Windows is divided in to several key elements 

 

 

 

  

 

  

Application Menu 
Used to interact with 
the application; 
Open/ Close/ Create 
new applications; 
Import/ Export 
information. 
The menu changes 
context based on 
what project object is 
open in the Work 
Pane 

Work Pane 
Open project object contents 
are display in this area. 

In this example, an untitled 
display has added to the 
application. 

Diagnostic List 
Contains status and error 
messages related to 
system, application and 
project. 

Explorer Pane 
Contains all objects 
related to an 
application project. 
Application objects 
are opened in the 
Work Pane. 

The Explorer’s 
content is described 
in more detail on the 
next page. 

Objects Toolbar 
Provides easy 
access to objects 
that are used on 
displays to create 
the user 
interaction.  Ex. 
Numeric Input, 
String Display, 
Ramp button, etc. 

Graphics Toolbar  
Provides easy 
access to tools 
that are used to 
manipulate objects 
on a display. 
Ex. Rotate, Group, 
Ungroup, etc. 
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Now let us take a close look at the objects in the Explorer Pane. 

 

 contains computer-scoped components, 
FactoryTalk View Data Server and FactoryTalk Services 
Platform objects. 

 contains application-scoped components like the 
FactoryTalk View HMI Server and RSLinx Enterprise 
configurations.  .  The FactoryTalk View Data Server object is 
used to add additional data servers (Ex. OPC) to an 
application project.  This is an advanced operation and not 
covered in the manual. 

 contains all information scoped to the HMI server 
such as, Project Settings, HMI Tags, Graphic files, Alarms, 
Information Messages, Macros, Data Logs, and Recipes. 

 contains project-scope settings such as 
Resolution, Security settings, Startup graphic files, Diagnostic 
configuration 

 contains all tags resident in the memory of the 
HMI Server.  Applications for Logix Controllers use direct tag 
referencing eliminating the need to create HMI tags to 
communicate with the PLC 

 contains all graphic images used in the 
application as displays, or contained within displays and 
parameter files.  Parameter files are one way to enable 
graphic reuse between applications. 

 Symbol Factory provides access to thousands of stock 
images organized in an easy to use library. 

 contains the application’s alarm configuration 
including triggers and messages. 

 contains the application’s information 
message configuration 

 contains the application’s macros 

contains any Data Log Model configured for the 
application 

 contains the Recipe management system 
configuration and any configured recipes  

contains communication shortcuts used 
by the application 

 contains FactoryTalk Services Platform related 
configuration.  This is primarily used to manage users and 
groups in a FactoryTalk Machine Edition application. 
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2. Click the New tab  to activate the tab. 

 

3. In the Application name  field, enter ‘L15’. 

 

 

The Import button  is used to import: 

� PanelBuilder application files for PanelView 
Standard or PanelView Enhanced. 

� PanelView Standard or Enhanced runtime files 

� Other FactoryTalk Studio for Machine Edition 
applications  

� This is analogous to using Application Manager 
to copy the project. 

4. Next, click the Create  button . 

After creating the application, FactoryTalk View Studio for Machine Edition opens the application: 

 

If you are unfamiliar with FactoryTalk View Studio for Machine Edition, please review the information 
in Exploring FactoryTalk View Studio for Machine Edition on page 30. 
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5. Maximize FactoryTalk View Studio by clicking the maximize  button  in the upper right-hand corner. 

6. Double-click the Project Settings  item located in the System  container to open its dialog. 

By default, new projects in FactoryTalk View Studio for Machine Edition are configured for a 
PanelView Plus 700/1000 terminal with a 640x480 resolution.  In this lab, you are using PanelView 
Plus 1000 terminals so these settings do not need to be changed.   

 

7. Click the Cancel  button   to proceed.  There is no need to change any setting on this dialog. 

 

 

Upon creation of a new project, FactoryTalk View ME 6.0 now automatically creates a default display 
called Main which is also defined as the initial startup display. Let’s open this now 

8. To open existing displays, open 
the Displays  container by 
clicking the expander   from 
the Explorer Pane  window. 
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9. Double-click on the Main  
display. 

The display will open in the 
Work Pane  of FactoryTalk View 
Studio for Machine Edition. 

You will notice that a Shutdown 
button has automatically been 
created for you.  You are now 
ready to add objects to the 
display. 

 

 

 

 

Adding Content to a Display 

All objects in FactoryTalk View Studio have properties.  The properties are organized by function on to 
tabs on a property dialog.  At a minimum, all objects provide a General and Common tab. 

Tab Name Purpose 

General Configure the operation and appearance of the object. 

Common Configure the object’s size (Height and Width) and display position.  
Display top-left corner is {0,0} coordinate. 

Each object provides a set of tabs that vary with the object type.  For instance, most objects that display 
static text (e.g. Text, Shutdown button) have a Label tab. 

Tab Name Purpose 

Label Configure an object’s caption font, font size, font color. 
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1. Select the Text  tool 
, and add a text box 

to the display. 

 

When you release the 
mouse button, the 
Text Properties  dialog 
will immediately open. 

2. Click the Text  field and 
enter ‘Hello World!  
This is my new  
application .’ 

3. Click the OK button 

. 

 
 

This display should now look similar to this 
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8. Close the display using the File > Close  menu item. 

9. When prompted, click Yes to save the changes.  

10. Now that you have created objects on the Main  display, verify that it is configured as the application’s 
Startup  graphic. 
 
To open the Startup  dialog, double-click on the Startup  item  in the System  container. 

 

11. Click OK to close the dialog. 

 

Creating the Runtime Application File 

1. Next, you must build the runtime application; select the Application > Create Runtime Application  
menu item. 
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2. Using the Create Runtime Application  dialog save the runtime project using the suggested name 
‘L15.mer ’ by clicking the Save button . 

 

 

While FactoryTalk View Studio for Machine Edition is 
creating the runtime MER file a progress dialog will 
appear 

 

The Conversion to development 
application  options allows later 
recovery of the design files from the 
runtime project using the Application 
Manager, if allowed. 

Always allow conversion 
[Default]  
The design information is always 
included with the runtime, so that it 
may be restored from the MER. 
The resulting MER requires more 
terminal memory to store the file. 

Never allow conversion 
Design information cannot be 
recovered from an MER created 
with this option selected. 
The MER created requires the least 
amount of terminal memory. 

Conversion protected by 
password 
When using Application Manager to 
extract the design information from 
the runtime file, the user will be 
prompted for the configured 
password. 
The resulting MER requires more 
terminal memory to store the file. 
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Downloading a runtime MER to a PanelView Plus terminal 

1. To download the runtime MER to the PanelView Plus 1000 terminal at your workstation, first, select 
the Tools > Transfer Utility  menu item. 

 

The Transfer Utility will open. 

 

2. Click the Source File  Browse  button  to select the runtime MER file to download. 

This opens the Select File to Download  dialog. 
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3. Click on the L15.mer  file to select the project.  The File Name  box should update to reflect the 
selection. 

 

4. Click the Open  button  to complete the project selection. 

5. Double-click the EtherNet, Ethernet  driver  to expand the item. 

 

6. Select the 192.168.1.20, PanelView Plus CE_6 1000, PanelView P lus CE_6 1000  item by clicking 
on it once. 

7. To initiate the download process, click the Download  button  

During the download, a progress dialog will update.  An example is shown below: 

 

When the download process completes a confirmation dialog is shown. 
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8. Click the OK button  to acknowledge the dialog. 

9. Click the Exit  button  to close the Transfer Utility. 

Running an Application on a PanelView Plus Terminal 

In this lab section, you will work with a PanelView Plus terminal.  Execute the following steps to run the 
FactoryTalk Machine Edition application you just completed. 

1. If FactoryTalk View ME Station is not already running on the terminal, double-tap the FTView ME 

Station  icon on the desktop.  

2. Press the Load Application [F1]  button. 

 

3. Select the L15.MER file from those available from the terminal’s Internal Storage. 

 

4. Press Load [F2]  to load the runtime file in to memory. 

5. When prompted, press Yes [F7]  to overwrite the terminal’s current communication configuration with 
the configuration contained within the L15.MER file. 

6. Once successfully loaded, press the Run Application [F2]  to start executing the runtime file. 

 

While the terminal is starting the application, an update dialog is displayed. 
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After the start-up processing completes you should see your applications startup display. 

 

7. Click the Shutdown  button to terminate the application. 

Congratulations!! 

You have successfully created a FactoryTalk View Studio for Machine Edition application; added 
application content; created a runtime file; downloaded the runtime file to a terminal; and, finally, ran the 
application on a PanelView Plus terminal. 
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Animating a Display with Control System Data 

Completing this section requires approximately 30 minutes. 

In this section you will learn how to: 

� Configure RSLinx Enterprise Communications for an application 

� Add ‘Live’ objects to a display 

� Test an application on the Desktop 

This application simulates a two-button pump control station. 

Configuring Communications 

1. Double-click the RSLinx Enterprise  item to expand. 

2. Right-click on the Communication Setup  item and select Open  to launch the RSLinx Enterprise 
Configuration Wizard . 

 

3. Select the Create a new configuration  option; this is the default.  
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The purpose of the different options is described here: 

Create a new configuration 

Generates an empty communication configuration scheme for the application. 

Copy an existing configuration from a previously created project 

Reuse a communication configuration from a different application file. 

Copy the configuration that is currently running on this workstation 

Infrequently used; copies the communication configuration from an application currently being hosted using 
FactoryTalk Machine Edition Station on the same workstation. 

4. Click the Finish  button .  The Communication Setup  dialog opens.   
You may need to resize the dialog. 

 

 



45 of 254 
 

Exploring the Communication Setup Dialog 
The Communication Setup dialog has three main areas. 

 

  

 

 

 

You will notice that the Network Path  dialog area has two tabs, Design (Local) , and Runtime (Target) .  The 
definitions below should help you to understand how to use these tabs, and why there provide powerful flexibility 
when designing an application.  These tabs allow you to develop and debug an application while at your desk, 
working on the shop floor, or some other location that is not co-located with the control system. 

The tabs can be used as described below 

Design (Local) Configure the network and device path(s) for the development 
environment in which the application will be designed and 
debugged.  This network topology and device path(s) may be 
different than the production environment where the application 
will ultimately run. 

If the development and production environments are identical, 
you can copy the Design (Local) configuration to the Runtime 
(Target) configuration using the Copy from Design to Runtime  

button . 

Runtime (Target) Configure the network and device path(s) for the production 
environment in which the application will run (e.g. customer 
facility).  The network topology and path(s) may be completely 
different than those defined using the Design (Local)  tab. 

  

 

 

Device Shortcuts 

A list of shortcuts 
defined on the 
workstation in RSLinx 
Enterprise. 

Offline Tag File  

Displays the hard drive path to the ACD file 
associated with the selected shortcut.  The offline 
ACD file is used for tag browsing when disconnected 
from a network. 

Network Path  

Displays the 
network topology 
path to the device 
associated with the 
selected shortcut. 

Also used to create 
a new shortcut to 
the select network 
device. 
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5. To create a new shortcut, click the Add  button  in the Device Shortcuts  area. When you click the 
Add  button, a new shortcut is created.  The shortcut’s name field is open and ready to be edited. 

 

6. Name the shortcut L15 by typing ‘L15’ and then pressing the [Enter]  key on the keyboard. 

If you have successfully completed these steps, the Communication Setup  dialog will look like this: 

 

7. Expand the EtherNet, Ethernet  driver by clicking the expander   once. 

8. Click the expander   once, to open the 192.168.1.1, SoftLogix 5800 EtherNet/IP, EtherNet/I P 
item. 

9. Click the expander   to open the 1789-A17/A, 1789-A17/A Virtual Chassis  item. 

10. Select 3, 1789-L60/A, 1789-L60/A SoftLogix 5860 Controller  by clicking on it once.  The dialog 
should now look like this after completing the last few steps. 

 

11. Click the Apply  button  to associate the selected device (e.g. SoftLogix 5800 Controller) with the 
selected communication shortcut (e.g. L15). 
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12. Click the Yes button  to confirm the association. 

 

13. Click the Verify  button  to confirm the association. 

 

Note, that for shortcut L15 only the Design path is assigned. 

14. Close the Shortcut Verifier  dialog by clicking the Close  button . 

In this lab, the design and production environments are identical.  To proceed you have two options: 

1. Use the Copy from Design to Runtime  button  to copy the design 
environment topology and device paths to the production environment (e.g. Runtime (Target) 
tab). 
It is estimated this option will require less than 5 minutes to complete. 
 

The Copy button should be used with care. All devices shown in the Design tab will be copied to the 
Runtime tab.  

The only devices required in the Runtime configuration are the controller(s) the PanelView Plus is 
communicating with.  

2. Manually configure the production environment so that you understand how this functionality 
works. 
It is estimated manual configuration will require 5 to 10 minutes to complete. 
 

For Option B  proceed to page 49. 
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Option A 

1. Click on the Runtime (Target)  tab  to select it and note there are two available 
drivers and no devices. 

2. Switch back to the Design (Local)  tab to click the Copy from Design to Runtime  button 
.  This copies the communication configuration from the Design (Local)  tab 

to the Runtime (Target)  tab. 

2. When prompted click Yes button  to confirm the operation.  

3. Click on the Runtime (Target)  tab to view the devices that have now been copied over. 

Using the expanders open the topology items (e.g. drivers and devices) to confirm that the Design 
(Local) configuration have been replicated. 

 

4. Proceed  to Step 19 page 52 to continue and skip Option B. 
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Option B 

1. Click on the Runtime (Target)  tab  to select it. 

2. Right-click on EtherNet, Ethernet  item to open the context menu. 

 

3. Click Add Device  which opens the Add Device Selection  dialog 

4. Expand the EtherNet/IP Devices  item by clicking the expander   

5. Scroll down  and expand SoftLogix 5800 EtherNet/IP  item by clicking the expander  . Select  the 
only SoftLogix 5800 EtherNet/IP  option in this list. 

 

6. Click the OK button  to accept the selection.  This action opens the Device Properties  
dialog. 
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7. Enter ‘192.168.001.001’ in the Address  field to set the device’s TCP/IP address. 

8. Change the selected Slot  to ‘4’. 

 

9. Click the OK button  to add the device to the Runtime (Target)  configuration. 

 

10. Use the expander to open the 192.168.1.1, SoftLogix5800 EtherNet/IP, SoftLogix 5 800 
EtherNet/IP  device. 

11. Right-click the 1789-A17, 1789-A17 Virtual Chassis  item and select Add Device . 
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12. Expand the 1789-L60/A, 1789-L60/A SoftLogix 5860  Controller item by double-clicking. 

 

13. Select the 1780-L60/A, 1789-L60/A SoftLogix 5860 Controller, M ajor Revision 18  item. 

 

14. Click the OK button  to accept the selection. 

15. Change the controller’s Slot  property to ‘3’. 

 

16. Click the OK button  to add the device to the Runtime (Target)  configuration. 

 

17. Click the Apply  button  in the Device Shortcuts  pane. 
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18. Click the Yes button  to apply the changes to the L15 shortcut. 

 

19. Click the Verify  button  to confirm the Design and Runtime associations. 

 

Confirm both the Design and Runtime devices are assigned for shortcut L15. 

20. Close the Shortcut Verifier  dialog by clicking the Close  button . 

21. Click the OK button  to complete the communication setup and close the Communication 
Setup  dialog. 

Be sure to use the OK button!  If you close the dialog with the Close  button , the communication setup 
will not  be committed to the application.  You will need to repeat the communication setup process. 

Adding ‘Live’ Objects to a Display 

Now that a communication path to a controller is configured, you are ready to add objects (buttons, 
numeric displays, etc.) to the display that use information from the controller.  The lab uses a variety of 
different buttons, data displays, and images to illustrate FactoryTalk Machine Edition functionality and 
application capabilities. 

1. Double-click the Main  display in the Explorer  to open the display. 

2. Right-click over the existing Text  object with the caption ‘Hello World!  This is my new application.’ 
and select Delete.   

3. Select the Maintained Pushbutton  tool  from the Objects  toolbar. 
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4. When you move the cursor over the Main  display frame, the mouse cursor will change to  

 

5. Move the mouse cursor near the lower left-hand corner of the Main  display frame; click and hold the 
left mouse button, and then drag down and to the right to create a Maintained Pushbutton  object. 

 

6. Position the cursor over the Maintained 
Pushbutton and double-click the mouse to 
open the Maintained Pushbutton 
Properties  dialog. 

 

7. Click the Common  tab to activate. 
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8. Change the Height, Width, Top,  and Left  fields to size and position the Maintained Pushbutton  
exactly. 

Height 60 

 

Width 120 

Top 400 

Left 20 

  

9. Click the Apply  button  to commit these changes.  The button should move and resize on 
the display to match these settings.   
If you’ve accidently clicked OK button, simply reopen the button’s property dialog by double-clicking 
the button. 

10. Click the States  tab to activate. 
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States are explicit events that occur when the value 
of the configured Connection: Value  tag equals the 
value defined in the Value for the selected state.  If 
the Connection: Value  tag value does not equal 
any defined state the Error  state occurs. 

Pushbuttons have three states: State0, State1, and 
Error.  By default, State0 is configured to occur 
when Connection: Value  tag value is zero; State 1 
when the tag value is one.  You can set a State’s 
Value  to any valid integer that the tag will assume.  
Most common are zero and one.  You can create a 
Normally Closed pushbutton by setting State0 
Value  to one, and State1 Value  to zero. 

There are other more complex state-based objects 
that you configure the operation for multiple states.  
These are called multistate objects; there are two: 
Multistate Pushbutton  and Multistate Indicator . 

The Multistate Indicator  is useful for depicting or 
emulating lamps, stack-lights, etc.  The Multistate 
Pushbutton  is useful for emulating multi-position 
selector switches, etc. 

11. Select State0  in the Select state:  field. 

 

12. Enter ‘Start Process ’ in the Caption  field. 

 

13. Click the Back color  color swatch in the General  group.  This will open a color picker. 

 

14. Select a shade of Green . 
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The dialog will update to reflect 
your selection. 

15. Click the Apply  button  to commit these changes.  The button will update to match the entry 
you made, a green button with the caption “Start Process”. 

16. Select State1  in the Select State:  field. 

 

17. Click the Back color  color swatch in the General  
group.  Select a shade of Red. 

 

18. Enter ‘Stop Process ’ in the Caption  field. 

19. Click the Apply  button  to commit these changes. 

20. Click the Connections  tab to activate. 

 

21. In the Value  row, click on the Browse  button  in the Tag column 

 

This action opens the Tag Browser 

Understanding the Tag Browser 

The Tag Browser  is used to view and select tags from the application’s configured data sources.  



57 of 254 
 

Understanding the Tag Browser 

When you configured RSLinx Enterprise  earlier in this lab, you were configuring a data source.  
Other data sources might be a PLC5 or SLC500 processor, or a device accessed using available 
KEPware drivers. 

 

 

Folder List  
Used to browse a 
shortcut’s Controller 
and Program tags 
and UDTs 

Tag Area  
Used to select a 
specific tag from the 
selected folder 

Tag Filter  
Shows only those tags that start with 
the user-entered filter.  Press [Enter] to 
apply a filter to the Tag Area . 
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Understanding the Tag Browser 

The following further defines and highlights the uses and functionality provided in the Tag Browser. 

Folder List  

 

HMI Server  (e.g. ) 
Contains tags defined in the HMI Server; 
referred to as memory tags.  The FactoryTalk 
Machine Edition runtime manages and 
updates these tags. 

System 
Contains default HMI tags for system 
information, such as, time of day, date, etc. 

<Communication Shortcut> (e.g. L15)  
Contains tags that exist in the memory of the 
device the shortcut represents. 

Diagnostic Items 
Predefined diagnostic and troubleshooting 
tags useful for monitoring communication and 
controller status. 

Online 
Tags contained in a Logix Controller’s 
memory; the tags are directly referenced by 
the FactoryTalk Machine Edition runtime. 

 

Tag Area  

 

Name 
Column containing the tag’s name.  Use the 
Tag filter  function to quickly find tags that 
start with the user-entered filter. 

Access Rights  
New!  In V18 firmware, Logix Controllers 
implements Access Rights for tags.  This 
column displays a tag’s Access Rights 
property.  Tags are either ReadOnly or 
ReadWrite. 
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22. Right-click on the L15 item in the Folders  list; select the Refresh All Folders  item.  

 

23. Double-click the L15 folder to expand. 

24. Double-click the Online  item to expand. 

 

25. Select the Program:MainProgram  item. 

 

26. In the Tag Area , locate and select the tag HMI_Start_Process.  
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Note that the Selected Tag  text box reflects your selection. 

27. Click the OK button  to 
complete the connection 
configuration. 

 

28. Click the OK button  to 
complete the button’s properties 
configuration.  You can now see a 
red colored button in the lower left-
hand corner of the Main  display. 

 

29. Select the Numeric Display  tool  from the Objects  toolbar. 

 

30. Move the mouse near the right-hand margin of the Main  display frame; click and hold the left mouse 
button, then drag down and to the right to create a Numeric Display  box. 
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31. Position the cursor over the Numeric 
Display  box and double-click the mouse to 
open the Numeric Display Properties  
dialog. 

 

32. In the Value Settings group decrease the Number of Digits  from 5 to ‘3’. 

   

33. Click the Common  tab to activate. 

34. Change the Height, Width, Top,  and Left  fields to size and position the Numeric Display  exactly. 

Height 40  

 

Width 120  

Top 180  

Left 75  

   

35. Click the Connections  tab to activate. 
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36. In the Value  row, click the Browse  button  in the Tag column to open the Tag Browser . 

 

37. In the Folder List, expand the path L15 > Online > Program:MainProgram > Tank1  and select the 
Pump  item.  

38. Select Flow_HMI_Entry  tag. 

39. Click the OK button  to 
complete the connection 
configuration 

40. Click the OK button  to 
complete the Numeric 
Display’s  properties 
configuration. 

 

This display now looks like this: 

  

To save time, you will now import additional display content.  Importing content from XML files is one 
way to reuse displays and objects between different FactoryTalk View Machine Edition applications.  
Some of the content will not be fully configured; once successfully imported you will complete the 
configuration of several objects. 
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41. Save the Main  display using the File > Save  menu item. 

 

42. Close the Main  display using the File > Close  menu item 

43. Right-click the Displays  item in the 
Project Explorer  and select Import 
and Export … 

 

 

44. This opens the Graphic Import 
Export Wizard dialog. 

Select Import graphic information 
into displays  item, and click the 

Next  button . 
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45. There is no need to backup the 
display that will be modified during 
the import.  Select No item, and click 
the Next  button . 

 

46. For the lab, you will be importing a 
single display.  Select Single display 
import file  item, and click the Next  
button . 

 

47. You must select the file to be 
imported.  Click the Browse  button 

. 

 

This opens a standard Microsoft 
Windows File Open dialog. 

 

 

48. Navigate to C:/Lab Files/ViewME - ViewPoint/ViewME/Beginner  folder 

49. Select the file Pump Content for Main Display.xml  

 

50. Click the Open  button . 
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51. Using the dropdown Select 
the display to import to  list, 
select the display named 
Main .  This is the display, to 
which the content must be 
added. 

 

 

52. The When importing  option should remain unchanged.   
The default setting Create new objects on the display  adds unique objects to the display during the 
import operation; it does not overwrite or update existing objects. 

53. Click the Finish  button  to begin the process. 

 

While the import is occurring a status dialog appears 

 

When the process completes a results file is displayed. 

 

54. Close the results file. 
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55. Open the Main  display from the Project Explorer . 

 

 

The import process has added two momentary pushbuttons, a gauge, a numeric input enable button 
and a pump.  You will need to complete the properties for some of these objects. 

The Numeric Input Enable Pushbutton  needs both its Minimum  and Maximum  connections 
configured.  During this lab, you have used an object’s properties dialog to configure an object.  In 
FactoryTalk View Studio for Machine Edition, there are many ways to change an object’s properties.  No 
one way is best; and which method you choose to use is a personal preference.  To complete 
configuration of the Numeric Input Enable  Pushbutton , you will use the Property Panel . 

56. Select the Numeric Input Enable Pushbutton  
with the caption Flow Rate  visible. 

57. Select Property Panel  menu item from the View  
menu. 

 

 

Numeric Input Enable button 
Opens a keypad for entering numbers. 

Gauge 
Displays numeric data 

Momentary Pushbutton  
Activates only while 
depressed 
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The Property Panel  presents an object’s properties as an 
alphabetically sorted list.  Some people find this arrangement 
for efficient to work with than the ‘regular’ tabbed Property  
dialog associated with each object. 

With the Property Panel,  it is possible to simultaneously 
change a property common to a group of selected objects 
(e.g. BackColor, Left, Width) by selecting the Shared 
Properties  radio button. 

 

  

Once the Property Panel  opens confirm the 
Properties  tab is active. 

58. Using the Property Panel  locate the property 
UseVariableMinMax .  You will have to use the 
vertical scrollbar to find the property. 

 

59. Using the UseVariableMinMax dropdown 
control select True . 

60. Click the Connections  tab to activate.   

61. Click the Browse  button  in the Tag column 
of the Minimum  row. 
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62. Using the Tag Browser select the tag 
::[L15]Program:MainProgram.Tank1.Pump. 
Flow_Min  

63. Click the OK button  to complete the 
tag selection process.  

64. Click the Browse  button  in the Tag column 
of the Maximum  row. 

65. Using the Tag Browser  double-click the tag 
::[L15]Program:MainProgram.Tank1.Pump. 
Flow_Max .  This selects the tag and closes the 
Tag Browser  in one step. 

 

66. Click the Close  button  (upper right-hand corner) to close the Property Panel . 

67. Save the Main  display using the File > Save  menu item. 

Testing an Application on the Desktop 

There are two methods available to test an entire application.  One is to download the application to a 
PanelView Plus terminal.  The other is to use the terminal emulation capability that is included with 
FactoryTalk Studio for Machine Edition.  You will be testing the application on the desktop using the 
terminal emulation functionality. 

1. From the Application  menu, select the Test 
Application  item. 

 

The system will build the runtime MER just 
as if the application were going to be 
downloaded to a PanelView Plus terminal. 

 

When the runtime MER file is built, the system loads the runtime MER in to an emulation mode.  The 
application will appear in the upper left-hand corner of the computer display. 
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2. To evaluate the application click on the Start Process  button, .  The button color and 
caption change.   

The color is now red and the caption reads Stop Process .  If the button is already in this state, 
proceed to the next step. 

3. Click the Numeric Input Enable Pushbutton  Flow Rate .  
This will open a numeric keypad. 

4. Set the Flow Rate to ‘230’ and click the Enter  button  

Note, that the minimum (10) and maximum (250) are 
displayed using the tags you had configured earlier. 
 

The Numeric Display  updates to reflect your entry. 
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5. Click the green Start  button to start the pump.  Several things happen at once. 

� The pump image will turn green with a shaded fill. 

 

� The gauge needle will begin to move. 

 

Take a few moments, but not too many, and exercise the application you created. 

� Change the flow rate (ex. 75), what happens to the gauge? 

� Press the Stop  button to turn off the pump.  What happens to the pump image?  The gauge? 

6. When you are done, click the Stop Process  button  to end the simulated process. 

7.  Click on the Shutdown  button to end the emulation. 

Congratulations!! 

You have successfully created your second FactoryTalk View Studio for Machine Edition application; 
added ‘live’ content; configured communications with a controller, created a runtime file; and, exercised 
the application on your desktop. 
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Adding Alarms to an Application 

Completing this section requires approximately 20 minutes; 

Annunciating irregular system or process events to operators is a critical component of many HMI 
applications.  FactoryTalk View Machine Edition provides an intrinsic alarming function that can be used 
for this purpose.   

In this section you will:  

� Learn about Alarms. 

� Configure several alarms for the pump application 

� Learn how to import alarms from reusable XML format 

When you have completed this section the application will appear as it did at the end of the last section, 
however, as the application executes simulated alarms will occur. 

Configuring Alarms 

In the simulated application, you are building an application where each Tank contains a User-Defined 
Data Type; referred to as a UDT.  The UDT is custom built by the control system designer using basic 
data types supported by a Logix controller (Boolean [Bool], Double Integer [DINT], etc.) and other UDTs.  
The UDT for a Tank contains a Pump.  The Pump UDT contains a Fault UDT.  You will be using tags from 
the TankX.Pump.Fault UDT structure. 

1. Double-click the Alarm Setup  item  in the Alarms  container within the Project Explorer.  

 

This action opens the Alarm Setup  dialog 
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Understanding the Alarm Setup dialog 

The native Alarm subsystem is a powerful feature available to every FactoryTalk View Machine Edition 
application.  The subsystem allows the designer to react to and annunciate irregular application events 
(e.g. motor overload, hi level conditions, etc.).  The alarm system can be configured to be entirely self-
contained to the application runtime, or it can be configured to coordinate and communicate with the 
control system. 

Used to define and manage the 
events that will ‘trigger’ an alarm 
to occur. 

The designed can also configure 
the system for alarm coordination 
with the control system. 

 

For each defined alarm event, 
the designer can configure the 
message that corresponds with 
the alarm. 

 

Allows the configuration of the 
system display on which to show 
alarms, the alarm history, and 
additional remote connections for 
control system coordination. 
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2. Click the Add  button  to begin the process of creating an alarm trigger.  This will 
open the Trigger  dialog. 

 

3. Click on the Browse  button  in the Tag column to open the Tag Browser.  

4. Expand the L15 > Online > Program:MainProgram > Tank1 > Pump  folder structure and select the 
Fault  container. 

 

5. Double-click on the FlowRateWarning  tag.  This selects the tag and closes the Tag Browser . 

Ensure that you selected the correct tag by verifying the tag in the Tag or expression  column 

 

6. Click the OK button  to complete trigger selection. 

7. Confirm the Trigger type  is set to Value .  This is the default setting. 
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8. Enter ‘Tank1 FlowRate ’ in the Trigger label  field to identify the trigger. 

9. Check the Use ack all value  checkbox; enter ’1’ as the Use ack all value .  The FactoryTalk View 
Machine Edition application sends this value to the control system, via a configured Ack  tag, when 
the operator depresses the Ack All button. 

 

10. Click on the Browse  button  in the Tag column of the Ack  row to open the Tag Browser.  

 

11. Click on the Pump  container in the path L15 > Online > Program:MainProgram > Tank1  to select. 

 

12. Select the Alarm_Ack  tag by clicking on it once. 

 

13. Click the OK button  to complete Ack  tag selection. 

14. Click the Add  button  to begin the process of adding the next trigger. 

15. Click on the Browse  button  in the Tag column to open the Tag Browser.  

16. Expand the L15 > Online > Program:MainProgram > Tank1 > Pump  folder structure and select the 
Fault  container. 

17. Click on the HiFlowWarning  tag. 
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18. Click the OK button  to complete trigger selection. 

19. Confirm the Trigger type  is set to Value .  This is the default setting. 

20. Enter ‘Tank1 HiFlow ’ in the Trigger label  field to identify the trigger. 

21. Check the Use ack all value  checkbox; enter ‘1’ as the Use ack all value  

22. Click on the Browse  button  in the Tag column of the Ack  row to open the Tag Browser.  

23. Click on the Pump  container in the path L15 > Online > Program:MainProgram > Tank1  to select. 

24. Double-click the Alarm_Ack  tag to select. 

 

Next, you must configure the message to be displayed for each alarm trigger you defined. 

25. Click on the Messages  tab to activate. 
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26. First, you need to resize the Trigger  column so that you can read the complete trigger name.  Move 
the mouse cursor so it is between the Trigger  and Trigger value  columns.  The cursor will change to 

a  when you have the mouse properly positioned. 

 

27. Click and hold, then drag the mouse to the right.  This will enlarge the Trigger  column.  Release the 
mouse button when you are done. 

 

28. Click in the Trigger  column to start the process.  You will notice that a dropdown list control is 
enabled within the column.  Using this dropdown list, you can select from among the defined 
Triggers  for which you will define a message. 

 

29. Click on the Trigger  dropdown control of Row 1 to show a list of the defined triggers. 

 

30. Select the trigger ::[L15]Program:MainProgram.Tank1.Pump.Fault.FlowRateWa rning . 

31. Click in the Trigger Value  column of Row 1  and enter ‘1’.  This configures the alarm system to 
generate an alarm when the tag Tank1.Pump.Fault.FlowRateWarning  is set to one. 

32. Click in the Message  field of Row 1  and enter ‘Tank 1 Flow Obstructed ’. 

 

33. Click on the Trigger  dropdown control of Row 2  to show a list of the defined triggers. 
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34. Select the trigger ::[L15]Program:MainProgram.Tank1.Pump.Fault.HiFlowW arning . 

35. Click in the Trigger Value  column of Row 2  and enter ‘1’.  This configures the alarm system to 
generate an alarm when the tag Tank1.Pump.Fault.HiSpeedWarning  is set to one. 

36. Click in the Message  field of Row 2  and enter ‘Tank 1 High Flow ’. 

There is no need for you to change the default settings of any other column in the Alarm Setup  
dialog Messages  tab. 

37. Click the OK button  to complete the Alarm Setup .  

To save time in the hands-on lab environment you will now import additional triggers and messages for 
Tank1, Tank2 and Tank3.  Just as FactoryTalk Studio for Machine Edition supports reusability for 
displays, it also provides reusability of Alarm setups via XML files. 

38. Right-click on the Alarm Setup  item in the 
Project Explorer  and select the Import and 
Export…  item. 

  

39. Select the Import alarm configuration into 
application  radio button. 

40. Click the Next  button  to proceed. 

 

41. Select No when asked about backing up the 
existing configuration and click the Next  button 

 to proceed. 

 



78 of 254 
 

42. Click the Browse  button .  This opens the 
Choose alarm configuration file to import  
dialog. 

43. Navigate to C:\Lab Files\ViewME - 
ViewPoint\ViewME\Beginner  

44. Select the file Alarm Content for Tank2 and 
Tank3.xml. 

45. Click the Open  button . 

 

46. Click the Finish button  to start the 
import. 

 
 

The FactoryTalk Studio for Machine Edition alarm importation process is destructive.  During 
the import, any existing alarm setup is replaced with the setup being imported.  Normally you 
would export the current alarm setup and manually merge with the alarm setup that will be 
imported. 

47. Close the AlarmImportLog.txt  file by clicking the  button. 



79 of 254 
 

48. Double-click the Alarm Setup  item  in the Alarms  container within the Project Explorer.  

There should be twelve defined triggers; 

 

and, twelve defined messages. 

 

49. Click the OK button , or the Cancel button , to close the Alarm Setup  dialog. 

Testing Alarms 

Next, you need to exercise the Alarm configuration in a running application.  To accomplish this you will 
once again use FactoryTalk Studio for Machine Edition’s Test Application  function.  

1. Click the Test Application  button  in the 
toolbar or use the Application > Test 
Application  menu. 

 

The system will build the runtime MER just 
as if the application were going to be 
downloaded to a PanelView Plus terminal. 
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When the runtime MER file is built, the system loads the runtime MER in to an emulation mode.  The 
application will appear in the upper left-hand corner of the computer display.  

 

To observe how alarms work: 

2. To evaluate the application click on the Start Process  button .  The button color and 
caption change.   

The color is now red and the caption reads Stop Process .  If the button is already in this state, 
proceed to the next step. 

3. Click the Flow Rate button  

4. Enter a value of ‘15’ using the keypad. 

5. Click the Start  button.  

A Flow Rate setting below 20 that persists for more than ten seconds generates a Low Flow Rate 
fault.  After approx. ten seconds, the Alarm Banner  should appear. 
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This is FactoryTalk View Machine Edition’s simplest alarm display.  By default, it only shows you the 
most current alarm.  FactoryTalk View Machine Edition provides additional Alarm objects to provide 
more functionality.  For example, later in this lab you have the option to add an Alarm History  to this 
application. 

6. Click the Ack Alarm [F1]  button , or depress the F1 key on the keyboard to acknowledge the 
“Tank 1 Low Flow Rate” alarm. 

7. Quickly  press the Flow Rate  button and enter a value of ‘25’.   
You must act quickly because if you are slow the Low Flow Rate alarm will re-occur. 

8. After approx. ten seconds, press the Flow Rate  button again and enter a value of ‘245’. 

While the flow rate is ramping up, after a few seconds the system should display a  
“Tank 1 Flow Obstructed” alarm. 

9. Approx. ten seconds later, the system should display a “Tank 1 High Flow Rate” alarm. 

10. Click the Ack Alarm [F1]  button , or depress the F1 key on the keyboard to acknowledge the 
“Tank1 High Flow Rate” alarm. 

Remember, in its default configuration the Alarm Banner  displays the most current alarm.  Thus, the 
‘Tank 1 High Flow Rate’ alarm superseded the ‘Tank 1 Flow Obstructed’ alarm. 

11. Click the Stop Process  button  to end the simulated process. 

12. Click the Shutdown  button to end the FactoryTalk View Machine Edition Test Application  
emulation. 

Congratulations!! 

You have successfully created a FactoryTalk View Studio for Machine Edition application that uses 
alarms, created a runtime file; and, exercised the application on your desktop. 
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Chapter 3: FactoryTalk View Machine Edition - 

Advanced 

Completing this section requires approximately 25 minutes. 

Symbol Factory is a new graphics library interface that can be launched from FactoryTalk View Studio 
v6.0. It is a common library between FactoryTalk View ME and SE. Symbol Factory is built on Software 
Toolbox’s Symbol Factory, and contains over 5,000 graphical objects. Approximately 4,000 of these are 
vector graphics, the remainder are static bitmaps. The Symbol Factory library supports drag-and-drop and 
copy/paste onto a native FactoryTalk View display.  

In addition to the addition of the Symbol Factory graphics library, FactoryTalk View ME v6.0 also provides 
improved color animation.  Color animation now has a Shaded fill type which gives depth to the object’s 
current state by using a tight dot pattern to give the appearance of shades.  While choosing the new 
Original fill type option allows you to keep the look and feel of the original object. 

In this section you will get a look at the following new features available in v6.0 of FactoryTalk View ME: 

� Symbol Factory library 

� Enhanced color animation 

Opening FactoryTalk View Studio 

You need to start FactoryTalk View Studio to work with a FactoryTalk View Machine Edition application.  

1. On the Windows Start  menu, select Programs > FactoryTalk View Studio : 
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Note that you can also select Programs > Rockwell Software > FactoryTalk View > F actoryTalk 
View Studio  on the Start menu.  

2. Select the InstantFizz Advanced  project in the existing application list. Verify that English  is the 
selected Language  and click Open .  

 

FactoryTalk View Studio loads the application – it will take a few seconds.  

3. Click the Maximize  button  to maximize FactoryTalk View Studio. 

 Using Symbol Factory graphics 

In this section you will create a new display, add a Multistate Pushbutton and Multistate Indicator to the 
display and edit those objects to display graphics from the new Symbol Factory library. This will allow you 
to get a look at the types of graphics that can be found in the Symbol Factory library, as well as how the 
library fits into the FactoryTalk View Studio interface. 
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Overview of the FactoryTalk View Studio interface 
 

 

Menu bar  – contains the menus for the active window. Available windows depend on which type of 
editor or window is active.  

Toolbar(s)  – contains buttons for commands commonly used in the active window.  

Explorer window  – displays folders containing FactoryTalk Directory structure and FactoryTalk View 
Studio editors. At the top is the local computer and local directory, below them are application-specific 
folders, and at the bottom are system and security folders. The Explorer includes the Application 
window and the Communications window, accessible through tabs at the bottom.  

Workspace  – graphic displays and various editors are displayed in this area, depending on what is 
selected in the Explorer. If Workbook Mode is selected on the View menu, this pane displays tabs 
that allow you to switch between each currently open display or graphic. 

Diagnostics list  – the exact information displayed here depends on how FactoryTalk Diagnostics 
has been set up, but generally this list displays messages from FactoryTalk Diagnostics.  

Status bar  – provides information about the active window or selected tool or command.  

Create a new display 

1. Expand the Graphics  folder in the Explorer pane. Right-click Displays  and select New to create a 
new Display. 

FactoryTalk View 
Studio menu bar and 
toolbar(s)  

Workspace 

Diagnostics list 

Status bar 

Explorer window 
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A new display is opened in the workspace area.  

Add and configure a Multistate Pushbutton 

1. Select the Multistate Pushbutton  object in the Objects toolbar, 

 

then click and drag the mouse to draw a square on the display: 

 

When you release the mouse button, a Multistate Pushbutton is drawn on the display. 

2. Double-click the new Multistate Pushbutton  to open its properties window.  
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3. On the General  tab you can configure general properties of the Multistate Pushbutton, such as its 
appearance and the number of states. Set the Border style  to None  and the Back style  to 
Transparent : 

 

4. Click the States  tab to configure button states. Select State0  to configure a graphic image to display 

on the button for the “off” or 0 state. Click the browse button  to select an image as shown below. 
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The Image Browser  is opened: 

 

5. Images listed on the Image Browser are in the FactoryTalk View ME Image library. To select an 
image from the new Symbol Factory graphic library, click the Launch Library…  button as shown 
above. The Symbol Factory library is opened, with 3-D Pushbuttons Etc  displayed: 
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Select a pushbutton graphic in the “off” state, such as:  

 

6. Click the Copy  button to copy the selected button to the Windows clipboard: 

 

The Symbol Factory library window is automatically minimized. 

7. Click the Paste from Library  button to paste the graphic you selected from Symbol Factory into the 
project’s Image library. You will be prompted for a unique image name; leave the default name of ‘3-D 
red button (not pressed) ’ and click OK. The selected image is shown in the Preview box: 

 

Note that images are copied from the Symbol Factory library to the project’s Image library so that they are 
included when you back up the project and move it to another location. You can see the Symbol Factory 
image in your project’s Image library by opening the Images folder in the application Explorer and looking for 
the 3-D red button (not pressed) image. 

8. Click OK to apply the image to your pushbutton.  

9. Click the Image scaled  checkbox to scale the State0 graphic to the size of your pushbutton: 
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10. Now repeat these steps for pushbutton State1 .  

Select State1  to configure a graphic image to display on the button for the “on” or 1 state. Click the 

browse button  to select an image: 

 

11. Click Launch Library…  to select an image from the new Symbol Factory graphic library.  

12. This time, select a pushbutton graphic in the “on” state, such as:  

 

13. Click the Copy  button to copy the selected button to the clipboard: 

 

The Symbol Factory library window is again automatically minimized. 

14. Click the Paste from Library  button to paste the graphic you selected from Symbol Factory into the 
project’s Image library. You will be again prompted for a unique image name; this time give the 
graphic a name of ‘3-D red button (pressed) ’ and click OK. The selected image is shown in the 
Preview box: 
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15. Click OK to apply the image to your pushbutton.  

16. Click the Image scaled  checkbox to scale the State1 graphic to the size of your pushbutton. 

17. Click the Connections  tab to select a tag for your pushbutton. 

 

18. Click the tag browse button for the Value  property (as shown above) to open the Tag Browser: 

 

 

A Boolean tag called mybool  has been created for you. Click InstantFizz Advanced  in the Folder 
list, and select the mybool  tag in the list as shown below. Click OK. 

 

19. Click OK on the Multistate Pushbutton Properties dialog to accept all of your changes. 
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Add and configure a Multistate Indicator 

1. Select the Multistate Indicator  object in the Objects toolbar, 

 

then click and drag the mouse to draw a square on the display next to the Multistate Pushbutton you 
already added. When you release the mouse button, a Multistate Indicator is drawn on the display: 

 

 

2. Double-click the Multistate Indicator  to configure its properties.  

On the General tab, set the Border style to None  and the Back style to Transparent . Set the Number 
of states to 2: 

 



92 of 254 
 

3. On the States  tab, select State0 , then click the browse button to select an Image for the ‘off’ state:  

 

4. Click Launch Library…  on the Image Browser to select a graphic from the Symbol Factory library. 
The Symbol Factory library is opened, with 3-D Pushbuttons Etc  displayed. Browse the list of 
Categories  to find the Gadget Lights 1  category: 

 

Select a light graphic in the “off” state, such as:  

 

5. Click the Copy  button to copy the selected button to the Windows clipboard: 

 

The Symbol Factory library window is automatically minimized. 

6. Click the Paste from Library  button to paste the graphic you selected from Symbol Factory into the 
project’s Image library. You will be again prompted for a unique image name; this time give the 
graphic a name of ‘Pilot light (Red Off) ’ and click OK. The selected image is shown in the Preview 
box. 
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7. Click OK to apply the image to your Multistate Indicator.  

8. Click the Image scaled  checkbox to scale the State0 graphic to the size of your Multistate Indicator 
object: 

 

9. Now repeat these steps for State1. Select State1 . Click the browse button to select an Image for the 
‘on’ state:  

 

10. Click Launch Library…  on the Image Browser to select a graphic from the Symbol Factory library. 
The Symbol Factory library is opened, with the Gadget Lights 1  category still displayed. Select a 
light graphic in the “on” state, such as:  

 

11. Click the Copy  button to copy the selected button to the Windows clipboard. The Symbol Factory 
library window is automatically minimized. 

12. Click the Paste from Library  button to paste the graphic you selected from Symbol Factory into the 
project’s Image library. You will be again prompted for a unique image name; this time give the 
graphic a name of ‘Pilot light (Red On) ’ and click OK. The selected image is shown in the Preview 
box. 

13. Click OK to apply the image to your Multistate Indicator.  

14. Click the Image scaled  checkbox to scale the State1 graphic to the size of your Multistate Indicator 
object. 

15. Click the Connections  tab to select a tag for your Multistate Indicator. Click the tag browse button 

 to open the Tag Browser for the Indicator  property. 
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16. Select the Boolean tag called mybool  on the tag list and click OK. 

 

17. Click OK on the Multistate Indicator Properties dialog to accept all of your changes. 

Add a shutdown button 

At runtime, the Shutdown button is used to stop the running application, stop all project components, and 
return to Windows.  

1. Select the Shutdown  button  object on the Objects toolbar,  

 

then draw a Shutdown button at the bottom of the display so that the display looks like this: 

 

Double-click the Shutdown button to open its Properties dialog. 
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2. Click the Label  tab and Enter ‘Exit ’ for the shutdown button caption: 

  

3. Click OK to accept your changes.  

Test the application 

Now that you have added Multistate Pushbutton and Indicator objects, you can test your application.  

1. Click the Test Display  button on the toolbar.  

 

The display switches to test mode.  

2. Click the pushbutton  on your display. Watch as the pushbutton and the indicator light change to the 
‘on’ state. You should see the different Symbol Factory graphics you selected for each state. 

3. When you are finished, click the Edit Display  button on the toolbar to return to edit mode. 
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 Animation enhancements 

In this section you will add a Symbol Factory graphic to your display and configure enhanced color 
animation for it. 

Add graphics to the display 

1. Click the Objects  menu item and select Symbol Factory . (You must click in the display to give it 
focus and make the Objects  menu visible.) 

 

The Symbol Factory library is opened or restored from being minimized if it was not closed from a 
previous instance. 
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2. Browse the list of Categories  and select Pumps . The available types of Symbol Factory pump 
graphics are displayed: 

 

3. Look for the graphic called Centrifugal Pump 4 , as shown below: 

 

4. You can drag-and-drop graphics from the Symbol Factory library directly to a display; click the pump  
and drag and drop  it on your display. Minimize the Symbol Factory window when finished and resize  
the pump graphic to make it larger. Your display should now look something like this: 
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5. For comparison, you will also add a graphic from the existing FactoryTalk View ME graphics library. 
In the FactoryTalk View Studio application Explorer, expand Graphics  and then Libraries . Find and 
double-click the Motors Reliance  graphics library:  

     

6. Select the motor graphic shown circled above, and drag and drop  it to your display. Resize  it to be 
about the same size as the Symbol Factory pump graphic. Your display should now look something 
like this: 
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Configure animation for the graphics 

1. Right-click on the Symbol Factory pump graphic. Select Animation , then Color . The Animation 
dialog is opened to the Color  tab: 

 

2. First you must select the tag that the graphic will reference for its animation value. Click the Tags  
button to select a tag. The Tag Browser  is opened.  

Select the mybool  tag you used for the Pushbutton and Indicator objects and click OK. The tag  
name is shown in the Animation dialog. 

The default animation colors are red for a value of 0 and green for a value of 1. You will set the 0 (off) 
color to be the graphic’s “original” color and leave 1 (on) at green.  
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Leave the A) 0 state selected and choose Original  for the Fill Style: 

 

Note that the custom color selections are disabled when you select the Original  Fill Style. This is 
because the graphic is displayed in its original colors for the selected state.  

3. Select the B) 1 state to configure its color animation. You can leave the color selections for the B) 1 
state as is.  

4. For the B) 1 state Fill Style , select Shaded . 

 

5. Click Apply  to apply your animations, then Close  to close the dialog.  

6. Now configure the color animation for the FactoryTalk View ME library graphic. Right-click the motor 
and click Animation , then Color . The Animation dialog is opened. 

7. Just like with the Symbol Factory graphic, you first need to select the Tag that will be referenced for 
the graphic animation. Click the Tags  button to select a tag. The Tag Browser  is opened.  

Select the mybool  tag you used for the Pushbutton and Indicator objects and click OK. The tag name 
is shown in the Animation dialog. 

The default animation colors are again red for a value of 0 and green for a value of 1. You will set the 
0 (off) color to be the graphic’s “original” color and leave 1 (on) at green.  

Select the A) 0 state and choose Original  for the Fill Style. 
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8. Select the B) 1 state to configure its color animation. You can leave the color selections for the B) 1 
state as is.  

For the B) 1 state Fill Style, select Shaded . The Animation Color tab should look like this: 

 

9. Click Apply  to apply your animations, then Close  to close the dialog.  

Test the graphic animation 

1. Click the Test Display  button on the toolbar to try your animation.  

 

The display switches to test mode.  

2. The pushbutton, indicator, and two graphics should be in the ‘off’ state. The motor and pump should 
be in their original colors.  

Click the pushbutton  on your display to see the color animations. The Symbol Factory object 
shading should be retained but with its color changed to green. The FactoryTalk View ME graphic 
shading should also be retained. In previous versions of FactoryTalk View ME, shading was not 
retained for graphic color animations.   

3. When you are finished, click the Edit Display  button on the toolbar to return to edit mode. 
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Test the application 

Recall that there are two methods available to test an entire application.  One is to download the 
application to a PanelView Plus terminal.  The other is to use the terminal emulation capability that is 
included with FactoryTalk Studio for Machine Edition. 

You will be testing the application on your PanelView Plus terminal but before the application can be 
executed on either the desktop or on a terminal, you must set the Startup  configuration. This 
configuration allows you to specify which project components to start at run time. It is very important to set 
the initial display for an application. 

Set the startup configuration 

1. First, save the new display you created in the last section. Click the Save button: 

 

You are prompted for a name for the display. Enter ‘SFDisplay ’ and click OK.  

 

2. Now find and double-click Startup  in the application Explorer: 

 

The Startup configuration dialog is opened.  
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3. Select the SFDisplay  in the Initial graphic  list: 

 

All other settings can remain at their default. Click OK to accept your configuration.  

Running the application on a PanelView Plus terminal 

Now you will test the entire application on your PanelView Plus terminal. To do this, you have to build a 
run time application and transfer it to the PanelView.  

Build the .MER 

1. Select Create Runtime Application  on the Application  menu: 

 

2. On the Create Runtime Application  dialog, verify that the runtime file name is ‘InstantFizz 
Advanced.mer ’.  

The file is saved to the default Runtime file location, C:\Documents and Settings\All 
Users\Documents\RSView Enterprise\ME\Runtime . 



104 of 254 
 

 

The Conversion to development application  options on the Create Runtime Application dialog allow later 
recovery of the design files from the runtime project using the Application Manager, if allowed. Options are: 

Always allow conversion [Default]  
The design information is always included with the runtime, so that it may be restored from the .MER. 
The resulting .MER requires more terminal memory to store the file. 

Never allow conversion 
Design information cannot be recovered from an MER created with this option selected. 
The .MER created requires the least amount of terminal memory. 

Conversion protected by password 
When using Application Manager to extract the design information from the runtime file, the user will be 
prompted for the configured password. 
The resulting .MER requires more terminal memory to store the file. 

 

The FactoryTalk ViewPoint version  option allows the user to specify whether or not published displays will 
be included in the MER file.  

Include ViewPoint Content  

Must be selected for the application to include the ViewPoint published displays. 
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3. On the Select Languages  dialog, make sure that English  is selected as the initial runtime 
application language and click Finish :  

 

A progress dialog will be displayed while the runtime file is being created.  

Download the runtime .MER to a PanelView Plus termi nal 

1. To download the runtime .MER to the PanelView Plus terminal at your workstation, click Transfer 
Utility  on the Tools  menu: 

 

Note that you can also click the Transfer Utility icon  on the toolbar.  
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The Transfer Utility is opened: 

 

2. Click the Source File  browse  button  to select the runtime .MER file to download. Select the 
InstantFizz Advanced.mer  file you created in the last step and click Open .   

 

3. Double-click the EtherNet, Ethernet  driver  to expand the item. 
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4. Select the PanelView Plus found at IP address 192.168.1.20 by clicking on it once. (It may look 
different from the screen shot below.) 

 

5. Click Download  to transfer the runtime file to your PanelView Plus terminal.  

 

If you are asked if you want to overwrite the existing file, click Yes.  

6. You will see a progress bar, and when the download process completes a confirmation dialog is 
shown: 

 

Click OK to acknowledge the dialog. 

7. Click the Exit  button  to close the Transfer Utility. 

Run the application on a PanelView Plus terminal 

In this section, you will work with a PanelView Plus terminal. Follow the steps below on your terminal to 
run the FactoryTalk View ME runtime application you just created. 

1. If FactoryTalk View ME Station is not already running on the terminal, double-tap the FTView ME 

Station  icon on the desktop.  

2. Press the Load Application [F1]  button.  
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3. Select the InstantFizz Advanced.mer  file from those available from the terminal’s Internal Storage.  

 

4. Press Load [F2]  to load the runtime file into memory.  

5. When you are prompted, press Yes [F7]  to overwrite the terminal’s current communication 
configuration with the configuration contained within the InstantFizz Advanced.mer file. 

6. Once successfully loaded, press the Run Application [F2]  to start executing the runtime file. 

 

7. While the terminal is starting the application, an update dialog is displayed: 

 

8. After the start-up processing completes, you should see your application’s startup display. 

9. Click the pushbutton  on your display to see the color animations on the PanelView Plus terminal. 
The Symbol Factory object shading should be retained but with its color changed to green. The 
FactoryTalk View ME graphic shading should also be retained. In previous versions of FactoryTalk 
View ME, shading was not retained for graphic color animations.   

When you are finished, press the Exit  button to terminate the application. 

Congratulations!!!   You have successfully used the new Symbol Factory library and enhanced color 
animation feature of FactoryTalk View 6.0. 
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Chapter 4: FactoryTalk ViewPoint Machine Edition 

- Beginner 

Completing this section requires approximately 20 minutes. 

FactoryTalk® ViewPoint is an add-on to FactoryTalk View ME running on PanelView Plus that provides 
for a fully scalable, fully animated, read-only view of existing applications from a Web browser. 

To make information about your plant or process available on demand from a Web browser in your office, 
home, or hotel, all you have to do is select the FactoryTalk View graphic displays you want to make ready 
for the Web, and then publish the displays to the FactoryTalk ViewPoint Server which runs on a 
PanelView Plus. 

There is no installation of any Rockwell Software products on the browser computer: all you need to 
connect to a published FactoryTalk ViewPoint Web application is the name (or IP address) of the 
PanelView Plus hosting the FactoryTalk ViewPoint Server that stores the application. 

Once you enter a simple address directly into your Web browser using the name or IP address, the 
browser will connect to the published web application and open the initial display selected. Use navigation 
buttons in the application to view other published displays, or use the web browser's navigation tools. 

Displays in a FactoryTalk ViewPoint application are read-only. Graphic objects in the displays are fully 
animated; however, you cannot use the objects to write to tags or to start and stop HMI components. For 
example, a numeric input object with a tag connection will display the tag's current value, but will not 
permit downloads. 

About this Lab 

This chapter focuses on developing and running web applications for FactoryTalk View ME, using 
FactoryTalk ViewPoint ME. 

1. First, you will learn how to create a FactoryTalkViewPoint ME web application that will run on the 
FactoryTalk ViewPoint server installed on PanelView Plus.    

2. Second, you will run the application by connecting the ViewPoint client to the PanelView Plus. 
You will also explore other FactoryTalk ViewPoint features and capabilities, and use some of the 
advanced FactoryTalk View ME features from within FactoryTalk ViewPoint.   

Setting up a FactoryTalk ViewPoint ME application 

In this section, you will follow step-by-step instructions to complete the publishing process.  This process 
involves taking an existing FactoryTalk View ME application and creating a Web application using the 
FactoryTalk ViewPoint Administration tool.   
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You will learn how to: 

� Publish displays from an existing FactoryTalk View ME application 

� Configure FactoryTalk ViewPoint ME Security 

� Transfer the published application to the PanelView Plus terminal 

FactoryTalk ViewPoint Administration 

FactoryTalk ViewPoint’s configuration is done through the FactoryTalk ViewPoint Administration tool, 
launched from FactoryTalk View Studio. Here, the desired displays are selected and published so that 
they will be available to any browser client connecting to your operator interface terminal. 

With FactoryTalk ViewPoint ME, the Administration tool runs on the same computer as FactoryTalk View 
Studio and is installed using the FactoryTalk ViewPoint ME install available on the ViewPoint CD.  The 
FactoryTalk ViewPoint ME Administration tool is separate from the ViewPoint ME server that runs on 
PanelView Plus because the components used to convert and publish ViewPoint displays are not 
supported on the PanelView Plus and are too large to store on the terminal.        

For the purpose of this lab, FactoryTalk ViewPoint ME is already installed.  The install is available from 
the FactoryTalk ViewPoint CD or as a stand-alone install.  See Answer ID 66110 on the Rockwell 
Automation knowledgebase for more details. 

1. From the Start  menu, select Programs > Rockwell Software > FactoryTalk View > F actoryTalk 
View Studio or Programs > FactoryTalk View Studio  as shown below. 

 

If FactoryTalk View Studio is already open, select File > Open Application…,  then Yes when asked 
to Close the application that is currently open.  Skip to step 3.  

2. Select Machine Edition  on the Application Type Selection screen:  



111 of 254 
 

3. Open the existing project called InstantFizz Advanced VP .  

 

4. Select ViewPoint Administration  from the Application menu to launch the tool.   

 

The Administration tool should now be displayed. 
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Publishing a FactoryTalk View ME Application 

Use the FactoryTalk ViewPoint Administration tool to publish the displays that will be included in the web 
application.  You can easily select all displays or choose the displays on an individual basis.  These 
selected displays are then published and will be included with the runtime file when created. 

Let’s go ahead and publish the application. 

1. Maximize  the FactoryTalk ViewPoint Administration tool window. 

2. A list of displays within the InstantFizz Advanced VP  application will be displayed.   

3. Depending on the size and number of displays, the publishing process may take several minutes 
when performed for the first time.  Subsequent publish actions are optimized to analyze and prepare 
any displays that have been changed or selected to be published. In the interest of time, a majority of 
the displays have already been published and are currently selected in the Web Enable column. 
 
However, the 5 Packaging  display is not currently published so let’s add it to the list and complete 
the publishing process.  To publish the application, change the initial display to 3 Filling, select the 
checkbox next to 5 Packaging and click the Publish displays button. 

 
 
Observe progress as the tool analyzes the selected displays and prepares these displays to be 
hosted in the browser.  This will take a few minutes. 
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4. When the publishing process is complete, you will be provided with a link to the publishing report 
which will describe any errors or warnings that may have occurred during publication.  Any objects 
which are not supported in FactoryTalk ViewPoint will be listed as a warning. 

 
Feel free to open this report and review its content. Close the report when finished. 

 

You have successfully published the FactoryTalk View ME application.  Before we learn how to transfer 
the published displays to the PanelView Plus terminal, let’s configure security. 
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Configuring FactoryTalk ViewPoint ME Security 

FactoryTalk ViewPoint ME security allows you to secure access to the published web application.   

1. Select Security Settings  on the red navigation bar in the FactoryTalk ViewPoint Administration tool 
window. 

 
 

2. From the Security Settings area you can change FactoryTalk ViewPoint security for currently 
configured FactoryTalk users of the Machine Edition (Local) directory. There are currently 3 users 
(Maintenance, ShiftManager & PlantManager) that have been configured in FactoryTalk Security for 
this application.  Additional users can be added using FactoryTalk View Studio or the Administration 
Console.  Let’s start by giving the users, Maintenance & Plant Manager, access to the published web 
application. Check the Viewer  checkbox next to the Maintenance and PlantManager users. 

 

 

3. Since security is optional and disabled by default in FactoryTalk ViewPoint, we can enable security by 
clicking the: Require users to log on to open the published Web a pplication  checkbox.  When 
you are done, your security should be setup as follows: 
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4. Finally, you need to save the security settings.  Click the Save button. 

 

5. Close the FactoryTalk ViewPoint Administration Tool window by clicking on  in the upper right-
hand corner. 

Creating a runtime file with ViewPoint content 

Now that the selected displays have been published and security is configured, when the runtime file 
(*.MER) is created, the published displays and security settings will automatically be included in this file. 
The transfer of the MER file to the terminal will download the FactoryTalk View ME application as well as 
the published displays and security settings. 

In subsequent creation of the runtime application, FactoryTalk ViewPoint will automatically check to see if 
any of the selected published displays have been modified since their last publish. If they have, the newer 
version of those displays are re-published in the background before being included in the MER file. There 
is no need for you to launch the FactoryTalk ViewPoint Administration again! 

 

FactoryTalk ViewPoint is supported on the PanelView Plus 700-1500 terminals and allows one client 
connection in the FactoryTalk ViewPoint 1.1 release. Additional client licenses may be sold in a future 
release.  The PanelView Plus terminals must have a minimum of 64MB Flash and 128 MB RAM to use 
ViewPoint.   

As of 5.10.01 firmware (or higher), FactoryTalk ViewPoint is available as an option to load on the 
supported PanelView Plus terminals and is embedded into the firmware.  The firmware upgrade wizard is 
used to upgrade terminals in the field.  

The firmware can be downloaded from - http://support.rockwellautomation.com/ControlFlash/FUW.asp 
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1. Now let’s create our runtime application that you will download to the PanelView Plus.  Select 
Application > Create Runtime Application. 

  

 

2. Make sure Runtime 6.0 Application  is selected for the MER type.  Make sure the Include 
ViewPoint Content checkbox is selected; this will ensure that the ViewPoint published displays and 
security settings are included in the MER.  Click Save.  

  

3. Select Yes if prompted to replace existing file. 
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4. Verify English is the only language selected to include in the runtime application.  Click Finish.  

 
 

 
The selected default language of the application in the FactoryTalk View ME Language Configuration 
editor, will determine which language is published in FactoryTalk ViewPoint. Support for multiple 
languages is available as of FactoryTalk ViewPoint 1.1. However, only one language can be 
published at a time.   

5. As the runtime file is created, you will see the different stages. ViewPoint  is one of the stages in this 
process and it may take some time to incorporate all of the published displays. 

 

6. When the runtime file is finished compiling, launch the File Transfer Utility from the tool bar. 
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7. Click on  to browse for the runtime file. Select InstantFizz Advanced VP.mer  runtime file and 
click Open . 

 

8. Select the PanelView Plus at 192.168.1.20 and Download  your application to the terminal. 

 

9. If prompted, click Yes to overwrite the existing file. 
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10. Once the download completes, click OK and close the Transfer Utility 

 

11. Now, turn to your PanelView Plus .  Launch FactoryTalk View ME Station  from the desktop icon on 

the PanelView Plus if it is not already running.  

12. On the FactoryTalk View ME Station configuration screen, click Load Application [F1]  and select 
InstantFizz Advanced VP.mer . Then click Load [F2] and Yes [F7] to replace the existing 
communication settings.  

13. When the application is finished loading, click Run Application [F2] to start the Project. If you are 
unfamiliar with this project, please take a few minutes to explore the project on PanelView Plus before 
running it in FactoryTalk ViewPoint. 

Running an application in a browser 

The next two sections involve running the ViewPoint ME application in a browser. 

You can connect to an existing FactoryTalk ViewPoint application from any computer running a supported 
Web browser. All you need is the name or the IP address of the operator interface terminal (PanelView 
Plus 700 -1500) running the FactoryTalk ViewPoint Server for the application. 

What is Silverlight? 

FactoryTalk ViewPoint uses Microsoft’s Silverlight technology to visualize FactoryTalk View content in a 
browser. Microsoft Silverlight is a new Web presentation technology that was created to run on a variety 
of platforms to deliver applications for the Web. It enables the creation of rich, visually stunning and 
interactive experiences that can run everywhere: within browsers and on multiple devices and desktop 
operating systems.   

If Silverlight is not installed on a client computer that connects to the PanelView Plus and the client 
computer is connected to the internet, the client computer is automatically redirected to the Microsoft 
Silverlight installation site for download.  If the client computer is not connected to the internet, 
instructions for installing Silverlight are automatically provided in the browser.   

For the purpose of this lab, Silverlight has already been installed.   

Connecting a Client 

1. Launch Internet Explorer from the desktop icon and enter the following address: 
http://192.168.1.20/FTVP   where 192.168.1.20 is the IP address of your PanelView Plus. 
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2. Earlier, you had enabled Security and you are now required to login to access the ViewPoint 
application.  Login using the username ShiftManager  and password ShiftManager . 

  

3. Remember that you did not grant “viewer rights” to ShiftManager .  An error is displayed on the log on 
page. 

  

4. Login using the username PlantManager  and password PlantManager .  The PlantManager has 
viewer rights to the application. 
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5. In Internet Explorer, you will be redirected to the InstantFizz Filling  display since we had selected this 
as our initial display in the FactoryTalk ViewPoint Administration tool. The FactoryTalk ViewPoint 
screens automatically scales to fit the size of the browser window.  
 

 

6. Maximize the browser window if it is not already at full size. 

FactoryTalk ViewPoint provides a thin client solution for FactoryTalk View. There is no need to install 
and maintain any Rockwell Software on the client machine. This lowers total cost of ownership, 
minimizes downtime and improves security. FactoryTalk ViewPoint also provides convenient access 
to FactoryTalk View applications from anywhere (central office, home, internet) which extends the 
reach of visualization to remote, casual and mobile users such as plant managers, central 
maintenance engineers, OEMs and System Integrators.   

7. FactoryTalk ViewPoint provides a rich, interactive browser user experience.  All of the navigation built 
into the FactoryTalk View ME InstantFizz Advanced VP application also works in the browser.  

In Internet Explorer, navigate from the Filling  display to the Packaging  display to observe how the 
navigation functionality works in FactoryTalk ViewPoint. 
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8. The Packaging  display was added to the published displays list earlier on and should now be shown 
in the browser. Observe that the animation used to simulate the boxes moving along the line is fully 
functional in FactoryTalk ViewPoint. FactoryTalk ViewPoint supports full animation of FactoryTalk 
View ME displays without the need to refresh your browser. 

 

9. Navigate from the Packaging  display to the Labeling display. 

10. The Labeling  display should now be shown in FactoryTalk ViewPoint. Once again, observe that the 
labeling line is used to show line status and is updating dynamically. FactoryTalk ViewPoint is fully 
interactive and does not use static “screen captures” to display information in the browser. 
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11. Now, turn to your PanelView Plus  and navigate to the Labeling  display.  Use the ‘Product_Name’ 
Label button to change the product label currently used in the line.  Note how quickly the ViewPoint 
client updates back on the desktop computer.  Since FactoryTalk ViewPoint does not currently 
support tag writes, this change cannot be made from the ViewPoint client. 

 

12. Returning to your browser, resize the window by clicking on the bottom right hand corner of the 
Internet Explorer window, while holding down the left mouse key and dragging the window to a new 
size. If the Internet Explorer window is maximized, you can double-click on the top blue Internet 
Explorer title bar to re-size the window. 

Notice the screen resizes at runtime. This allows you to develop a single display and run it on a wide 
variety of client devices with different screen sizes and resolutions (including wireless, mobile 
devices).   

13. Navigate from the Labeling  display to the Languages display. 

14. The Languages  display is now shown over the navigation button that was just clicked on. This 
display has been configured in FactoryTalk View ME as a “pop-up” display and is supported by 
FactoryTalk ViewPoint.   
 

 
You’ll see a blank area where it appears as if some objects have been removed from the “pop-up” 
display. Any objects which are not supported by FactoryTalk ViewPoint are removed from the 
displays during the publishing process.   

15. Turn to your PanelView Plus  terminal and navigate to the same Languages  display. Note that the 
Language Switch Button objects, with flag images, exist within FactoryTalk View ME on the terminal 
but not within FactoryTalk ViewPoint on the desktop. This is due to the fact that these objects are 
unsupported in FactoryTalk ViewPoint. 

 
Support for language switching and alarming is targeted for a future release.  

16. In Internet Explorer on the desktop PC, click on the Close  button  to shut down the 
Languages  display. 
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Congratulations!  You have successfully published the FactoryTalk View ME InstantFizz Advanced VP 
application and can now connect to it using your web browser. Note that FactoryTalk ViewPoint 
automatically converted and published the displays to be included in the ME application; you did not need 
to make any modifications to the FactoryTalk View ME application to accomplish this.   

Keep the browser open and move to the next exercise to learn how to run the InstantFizz Advanced VP 
application using standard browser features. 

Using browser features with FactoryTalk ViewPoint 

We all use the internet frequently as a daily part of our work and home lives, so most people are familiar 
with how to use Browser functionality.   Many applications run in the browser but do not utilize the 
features of the browser.  One of the major advantages of using FactoryTalk ViewPoint is that it allows you 
to use the features of the browser that you are already familiar with and does not require the installation 
of any Rockwell Software.  This section focuses on exploring your FactoryTalk ViewPoint project using 
the features in the browser. 

Using Browser Features 

1. If the Internet Explorer on your PC is not currently open to ViewPoint, connect to the FactoryTalk 
ViewPoint server by typing the following link in Internet Explorer: http://192.168.1.20/FTVP  where 
192.168.1.20 is the IP address of your PanelView Plus. 

2. You will be instructed to enter this URL several more times throughout the remainder of the lab.  If 
you get tired of manually entering the URL, just use the Address Bar located at the top of the Internet 
Explorer window.  FactoryTalk ViewPoint supports all of the standard browser features! 

   

3. Navigate to several displays. Use the Back , then Forward  buttons in your browser. You will see that 
this allows you to navigate through your browser history just as if you were viewing any other website. 
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4. Select Favorites , then Plant Overview .  The use of pre-configured Favorites provides quick, on-
demand access to important FactoryTalk ViewPoint displays. 

 

5. Select Favorites  again and under the InstantFizz - PanelViewPlus  folder to select Packaging .  
Browser folders can help organize multiple Favorites to different applications. 

 

Congratulations!!!  We hope you have enjoyed using some of the features present in Internet Explorer 
that help make using FactoryTalk ViewPoint an intuitive and enjoyable experience.  You can keep your 
browser open and move to the next exercise. 
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Chapter 5: FactoryTalk ViewPoint Machine Edition 

- Advanced 

Completing this section requires approximately 25 minutes. 

This section focuses on using some of the advanced features that FactoryTalk View ME has to offer with 
FactoryTalk ViewPoint.   

In this section you will learn about the following FactoryTalk ViewPoint features: 

� Trending 

� Parameter Files 

� Symbol factory  

� Color animation 

� Inactivity Timeout 

If the InstantFizz Advanced VP application and your Internet Explorer browser are already open, you can 
skip to the next section, Trending .   

If not, please follow the steps below before proceeding to the next section. 

Opening the application 

1. Turn  to your PanelView Plus and launch FactoryTalk View ME Station from the desktop icon on the 

PanelView Plus if it is not already running.  

2. On the FactoryTalk View ME Station configuration screen, click Load Application [F1]  and select 
InstantFizz Advanced VP.mer .  

3. Click Load [F2]  then Yes [F7] to replace the existing communication settings.  

4. When the application is finished loading, click Run Application [F2] to start the Project. If you are 
unfamiliar with this project, please take a few minutes to explore the project on PanelView Plus before 
running it in FactoryTalk ViewPoint. 

5. To run the application in FactoryTalk ViewPoint, launch Internet Explorer  from your Desktop. 

6. Type in the following link in Internet Explorer address field: http://192.168.1.20/FTVP  where 
192.168.1.20 is the IP address of your PanelView Plus.   
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Trending 

FactoryTalk View ME trending is now supported in FactoryTalk ViewPoint.  During the publishing process, 
the FactoryTalk View ME trend control is replaced by a compatible Silverlight Web control developed by 
Rockwell Automation.  Therefore, the control will look differently in your browser than it does on the 
PanelViewPlus terminal. 

The FactoryTalk ViewPoint trend displays real-time data for the pens defined in FactoryTalk View Studio 
for the original trend object. Support for FactoryTalk View ME historical data is not available in this 
version.  The properties that are retained in a FactoryTalk ViewPoint trend, if they were configured in the 
original FactoryTalk View ME trend object, are: 

General tab 

Chart style (Standard only), Chart update mode (Automatic only) 

Display tab 

No display settings are supported. 

Pens tab 

Tag or Expression definition, Visible (On or Off), Width, Min and Max values    

X-Axis tab 

Chart time span, Major grid lines (number). 

Y-Axis tab 

Automatic (Use best fit for data), Preset (Use pens' Min and Max) and Custom (Actual min/max) value 
options, Major grid lines (number), Draw pens on independent scale (only). 

Common tab 

Size (overall) and Position settings. 

Connections tab 

Pen connections (tags or expressions) only.  

 

1. In the ViewPoint client, navigate to the Trend  display. 
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2. A FactoryTalk ViewPoint trend consists of the trend chart, the pens, a current value legend, a value 
bar, an X and Y axis, play and pause buttons, and a pan and zoom slider.  Note all the components 
that make up the trend control. 

 

 

3. The current value legend on the right edge of the trend chart lists all the pens defined in the original 
FactoryTalk View trend object.  It indicates the tag name or pen description, the value and color.  

Clear or select  the pen’s checkbox to hide or show the associated pen. 

 

Current value legend 

Value bar with 
pen markers 

Trend chart 

Y and X axes 

Pan and 
Zoom slider Play and pause 
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4. Click on the Good  pen to: display its value range on the Y-axis, highlight it in the trend chart and if it 
intersects the value bar, its tooltip will be larger than others on the value bar. 
 

 

 

5. Drag  the value bar across the trend data in a FactoryTalk ViewPoint trend to display values 
associated with specific trend data points. Note the pen values in the tooltip and current value legend 
also update to the value where the pen intersects the value bar 

 
 

6. Click Play  to resume viewing data from the point where the trend was paused 

7. The horizontal slider beneath the X-axis or the chart itself can be used to pan and zoom data. 

Click and drag  the left handle on the slider to zoom into the trend data. 
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8. Click and drag  the slider to pan the trend data. 

 
 

9. Pause the trend by clicking on the Pause  button under the legend and click anywhere on the trend 
chart to drag back and forth  as another method to pan the data. 

 

 

Symbol Factory 

Symbol Factory is built on Software Toolbox’s Symbol Factory, and contains over 5,000 graphical objects. 
Approximately 4,000 of these are vector graphics, the remainder are static bitmaps. The Symbol Factory 
library is now available in FactoryTalk View ME 6.0 and supported by FactoryTalk ViewPoint.   

1. In FactoryTalk View Studio, open the 8 Inventory display. 

 



131 of 254 
 

2. Right click on the pallet stack located on the conveyor and select Animation  then Horizontal 
Position  to view how animation is applied to a Symbol Factory object. 

 

The pallet is just one of the thousands of Symbol Factory graphic objects that FactoryTalk ViewPoint 
supports when used within your FactoryTalk View ME 6.0 application.  Object arrangement, such as 
grouping, and animation are an example of the functionality that can be applied to these graphic 
objects in the same manner they are used with native FactoryTalk View ME objects.   

3. Click Close   to shutdown the animation window. 

4. Switch to your internet browser and navigate to Packaging , then click on the Pallet Inventory  button.  

 

5. Now, turn to your PanelView Plus  terminal and also navigate to Packaging , then Pallet Inventory .   
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6. Click on the Start or Stop Motor Control buttons to start and stop the conveyor motor.  These button 
images are also part of the Symbol Factory library and have been used with a Maintained pushbutton 
object. 

   

Note how quickly the ViewPoint client updates back on the desktop computer.  Since FactoryTalk 
ViewPoint does not currently support tag writes, this change cannot be made from the ViewPoint 
client. 

 

 

 

Enhanced Color Animation 

FactoryTalk View ME color animation has been enhanced and now has a Shaded  fill type which gives 
depth to the object’s current state by using a tight dot pattern to give the appearance of shades.  While 
choosing the new Original  fill type option allows you to keep the look and feel of the original object.  
These new options are now supported in FactoryTalk ViewPoint. 
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1. In FactoryTalk View Studio, open the 8 Inventory display if it is not already open from the previous 
section. 

 

2. Double-click on the Conveyor Motor Control and Status object group, then single click on the motor  
object. 

 

3. Right click on the motor and select Animation,  then Color  to view how the new Shaded  and 
Original  color animation options have been used. 

 

4. Click on A) 0.  The Original fill type has been selected so that the motor will remain displayed with its 
original colors while in the ‘Off’ state. 
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5. Click on B) 1.  Note that the Shaded  fill type will be during the motors ‘On’ state.    

 

6. Click Close   to shutdown the animation window. 

7. Navigate to Packaging , then click on the Pallet Inventory  button in both Internet Explorer  running 
on your desktop and on your PanelView Plus  terminal. 

  

8. On your PanelView Plus  terminal, click on the Start or Stop Motor Control buttons to start and stop 
the conveyor. 

  

FactoryTalk ViewPoint updates between the motor’s Original coloring and the new Shaded option as 
it changes states. 
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Parameter Files 

Parameter Files are used with Display navigation buttons to load parameter files for a display. This 
FactoryTalk View ME functionality is supported in FactoryTalk ViewPoint. 

1. In FactoryTalk View Studio, open the 2 Blending display. 

 

2. Double-click on the Information  button , for Blending Tank 1  (far left) and view the Goto 
Display button properties. 
 

 

Note that the Tank1  Parameter file has been selected and will be passed to the 2A Blending – Tank 
Info display when the button is pressed.  Click Cancel  to close the properties window. 
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3. Double click on the Information  button,   , for Blending tank 2 (middle) and view the Goto 
Display button properties. 

 

Note that the same display has been selected here as it was for Tank 1, however, the Tank2  
Parameter file has been chosen so that the tags defined in that specific file will be passed when the 
button is pressed.  Click Cancel  to close the properties window. 

4. Under Graphics > Parameters  in the Explorer window, double click on the Tank1  parameter file. 
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Here we can see what tag is being passed into parameter #1. 

5. Repeat the previous step for the Tank2  parameter file and note the new tag that will be passed for 
Blending Tank 2. 
 

 

6. Switch back  to your internet browser and navigate to the Blending  display. Click on any of the Tank 
info buttons to call the display and its associated parameter file. 

We can see how tag data is successfully being passed into this pop-up display. The behavior of 
parameter files is the same in both FactoryTalk View ME Station and FactoryTalk ViewPoint.  Also 
note that the title bar text uses Embedded Variables  which are also supported by FactoryTalk 
ViewPoint. 

 

7. Close your internet browser window. 
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Inactivity Timeout 

FactoryTalk ViewPoint contains an inactivity timeout setting.  If a web browser has been inactive for a 
period of time, a message is displayed stating that the session has expired.  The inactive period is 
defined by a browser connected to the terminal with no display changes.  When the session expires, the 
client access license is released which allows another client to connect to the terminal.  If the application 
is secure, the currently logged on user will also be logged out. 

1. Connect to the FactoryTalk ViewPoint server by typing the following link in Internet Explorer: 
http://192.168.1.20/FTVP/ADMIN  where 192.168.1.20 is the IP address of your PanelView Plus. Pay 
special attention to include the /admin  at the end of the URL. 

Log on with the User Name: PlantManager  and Password: PlantManager  

 

2. The FactoryTalk ViewPoint Administration is served from the PanelView Plus to your browser.  The 
default inactivity timeout is 20 minutes.  The inactivity timeout can be disabled or you can modify the 
inactivity timeout period.  
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3. Change the inactivity timeout to 2 minutes and click the Apply  button. 

 

4. Connect to the running ViewPoint application by typing the following link in Internet Explorer: 
http://192.168.1.20/FTVP/  where 192.168.1.20 is the IP address of your PanelView Plus (hint: you 
can avoid typing the URL by using the address bar at the top of the browser window).  
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5. Before the session expires, open a 2nd tab or browser instance and try to connect to the terminal by 
typing the following link in Internet Explorer: http://192.168.1.20/FTVP/ .  Note that you are unable to 
connect to the terminal because the client license is already in use by tab 1. 

 

6. Switch back to the first tab and wait for the session to expire.  Remember, the session will not expire 
if you switch between displays.  When the session expires you will see the message below in your 
browser.   
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7. After the session expires, the currently logged in user is logged off and the client access license is 
now available for another client to connect.  Go back to the 2nd tab and refresh the browser.    

 

8. You can now log on with the User Name: PlantManager  and Password: PlantManager  

 

After log on, you can access the FactoryTalk ViewPoint application. 
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9. Connect to FactoryTalk ViewPoint Administration again by typing the following link in Internet 
Explorer: http://192.168.1.20/FTVP/ADMIN  where 192.168.1.20 is the IP address of your PanelView 
Plus. Pay special attention to include the /admin at the end of the URL. 

10. Change the Inactivity Timeout back to Default  settings and click Apply  

 

11. Close Internet Explorer (including all open tabs).   

Congratulations!!  You have successfully used FactoryTalk ViewPoint advanced features, like trending, 
parameter files, symbol factory, enhanced color animation and inactivity timeout.   
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Chapter 6: FactoryTalk Machine Edition - Pick and  

Choose 

This section of the lab is a collection of several smaller exercises designed to guide the user through 
additional features of FactoryTalk ME.  The format allows you to select the features you want to work with 
and you can complete these sections in any order. To help you choose, we have estimated the time it 
should take for each of them.  

The following table lists the available sections and the page number each starts on.  

This feature… Starts on page… 

Integrating other applications (10 minutes)  

 

144 

Recipe Management (15 minutes) 152 

Working with security (15 minutes) 170 

Additional Alarming Features (20 minutes) 183 

Language Switching (20 minutes) 196 

Improving productivity with parameter passing 
(30 minutes) 

213 

Logging data (20 minutes) 232 

Integrating other applications (10 minutes)  

Completing this section requires approximately 10 minutes. 

Sometimes, to integrate functions or restrict access to the desktop on a PanelView CE, the task of 
launching other programs needs to be done from within a FactoryTalk View ME application. This can be 
easily accomplished by using the Program Launcher ActiveX control.  

The Program Launcher ActiveX control allows the operator to launch an .EXE (executable) program from 
within a FactoryTalk View ME application. This tool allows users to view manuals, CAD drawings, 
spreadsheets, websites, even videos, without having to browse to the desktop or storage card. For more 
information on the Program Launcher ActiveX control, refer to answer ID 20474 in the Rockwell 
Automation Knowledgebase.  

 

With the new Foxit .PDF viewer, you can view files created with current versions of Adobe. It gives a clear 
and crisp view of all pictures and font styles on PanelView terminals, and navigation is by touch for zoom, 
next page/previous page, goto page, and rotate functions. From a FactoryTalk View ME application, you 
can also open a .PDF to a particular page number, bookmark, or named destination, as well as zoom and 
fit width. 

You are also able to use the Program Launcher to open files in Word and Excel viewers, a media player, 
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or Internet Explorer. The executable files for each of these file viewers are installed with FactoryTalk View 
Studio and Station on the desktop, and are pre-loaded and registered on the PanelView terminal.  

In this section you will: 

� Look at how the Program Launcher ActiveX control can be used to view a .PDF with the new Foxit 
file viewer that is installed on PanelView Plus. 

� Have the option to see how the Program Launcher opens files in Word and Excel viewers, a media 
player, or Internet Explorer. 

Open the InstantFizz Advanced application 

If you already have the InstantFizz Advanced application open from a previous section, you can move on 
to the next section, Adding a graphic display to a project . 

1. To open FactoryTalk View Studio, click Start > All Programs > Rockwell Software > FactoryT alk 
View > FactoryTalk View Studio .  If FactoryTalk View Studio is already open, then select File > 
Open Application…  to switch applications. 

2. Select the existing InstantFizz Advanced  application, make sure English  is selected for the 
Language , and click Open : 

 

Adding a graphic display to a project 

You have been provided with a ready-to-use display called Program Launcher . You will need to add the 
display to the project.  
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1. In the application Explorer, right-click Displays  and select Add Component Into Application .  

 

2. Browse to C:\Lab Files\ViewME - ViewPoint\ViewME\Pick and Cho ose  folder and select Program 
Launcher.gfx . Click Open  to add the display to the project. 

Configure the Program Launcher ActiveX properties 

Now, you will need to configure its properties to allow the program launcher to launch a specific 
executable (.EXE) at run time. 

1. Find the Program Launcher  display in the application Explorer and double-click to open it.  

 

The Program Launcher display opens:  
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New to FactoryTalk View ME v6.0, the ActiveX controls are installed and registered for you.  There is 
no need to have to register these controls manually. 

 

2. With the Program Launcher display open, click Object Explorer  on the View  menu.  

 

The Object Explorer is opened. Group 4 includes the push button control and the Program Launcher 
control for opening a .PDF file with the Foxit PDF Viewer. Expand Group 4  and double-click 
MEProgramLauncher4  to open the Properties dialog for the Program Launcher control.  
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3. Click the Connections  tab. The following are the available properties for the Program Launcher 
control:  

� ProgramLocation  – This is the complete path and filename of the EXE program you wish to 
execute (ex. "ctlpnl.exe"). This property can be a string or a string tag. This property cannot be 
empty and is not optional. 

� ProgramParameter  – Some programs require a parameter to be typed at the command line (ex. 
"\Windows\cplmain.cpl,5"). This property is used with the ProgramLocation. This property can be a 
string or a string tag. This property is optional. 

� FocusEnable  – While another program is running, the FactoryTalk View ME project may not be 
visible if it is in the background and/or minimized. This property will restore the FactoryTalk View 
ME project and bring it to the foreground of Win32 or Win CE. This property is triggered on a zero-
to-one transition. This is a BOOL (i.e. Digital) property and is optional. 

� LaunchEnable  – Although the ActiveX control is a button, you may want to trigger it from a tag 
instead. This property will trigger the ActiveX control when the assigned tag goes from a zero to 
non-zero transition. This is a BOOL (i.e. Digital) property and is optional. 

� NewInstance  - This property defines what to do if the specified program (ProgramLocation) is 
already running. Set this property to 0 to restore the already running program. Set this property to 1 
to open a new instance of the program (if the program supports this). This is a digital property and 
is not optional if launching multiples of the same application. 

Below is a snapshot of the properties of this specific Program Launcher ActiveX Control configured in 
FactoryTalk View Studio. Notice the “ProgramLocation”  property is set to a tag called 
“FoxItProgramLocation”. This tag contains the path name of the new Foxit .PDF viewer’s executable 
on the PanelView terminal. The “ProgramParameter”  property is set to a tag “FoxItFileLocation”, 
which contains the path name (on the PanelView terminal) of the .PDF file to open. These two 
properties can also accept the path directly; you can see that configuration on one of the other 
Program Launcher controls. Finally, the “LaunchEnable”  property is set to the tag associated with 
the pre-configured push button. A new instance of the Program Launcher ActiveX will be needed 
every time a different executable or parameter needs to be launched. This is a typical property set up 
of the Program Launcher ActiveX control. For more technical information regarding these properties, 
please refer to answer ID 20474 in the Rockwell Automation Knowledgebase. 
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Each button on the Program Launcher display has its own Program Launcher ActiveX object, with 
different property configurations on its Connections  tab to open the corresponding .EXE.  

4. Now that you have seen how the Foxit Reader is launched with the Program Launcher ActiveX 
control, open the properties for each of the other Program Launcher controls on the display and look 
at how they call up the different applications.  

5. When you are finished looking at the Program Launcher controls’ settings, you need to create a run 
time file to download to your PanelView terminal. Before you do that, you need to change the startup 
display in the application. Double-click Startup  in the application Explorer, check the Initial graphic 
checkbox if it isn’t selected already and select 1 Overview as the Initial graphic . Click OK when you 
are done. 

 

6. Click Create Runtime Application  on the Application  menu to create the run time .MER file.  
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7. Make sure the file is named InstantFizz Advanced.mer  and the Runtime 6.0 application type is 
selected, then click Save.  

 

Click Yes if asked if you want to overwrite the existing file. Select English  as the initial runtime 
language and click Finish . 

The run time file is created. It will take a minute or two to compile the application and generate the 
.MER file. 

8. When it is finished, click the Transfer Utility  button on the FactoryTalk View Studio toolbar:  

 

9. Click the browse button for the Source file and select: C:\Documents and Settings\All 
Users\Documents\RSView Enterprise\ME\Runtime\Instan tFizz Advanced.mer . 

10. In the bottom pane, select your PanelView Plus  terminal as the destination. The Transfer Utility 
should look something like this: 
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Your terminal may look slightly different – look for the PanelView Plus terminal with the IP address of 
192.168.1.20. 

11. Click Download  to download the project to the terminal. If you are asked if you want to overwrite the 
destination file, click Yes. You will see a progress bar, and when the download is complete a 
message box will tell you the download completed successfully. Click OK.  

12. Click Exit to close the Transfer Utility.  

Using the Program Launcher on a terminal 

1. Move over to your PanelView Plus terminal. If FTView ME Station  is not already running, start it by 

double-tapping the icon on the desktop:  

2. Tap Load Application [F1] . Select InstantFizz Advanced.mer  in the file list, then tap Load [F2] .  

3. Tap Yes to replace the communications setup. When the application is loaded successfully, you will 
see the file name in the Current application  box. Tap Run Application [F2]  to run your project.  

4. Tap the Extended Capabilities Lab  button on the Overview  display, then the Program Launcher 
ActiveX Display  button. Try each of the Program Launcher buttons to see how they work at run time. 
Feel free to work with the Foxit .PDF Reader and try its new features. 

5. Tap Exit  to close the application when you are finished. 

Congratulations!!  You have successfully used the Program Launcher ActiveX control with the new Foxit 
file viewer to view a .PDF file as well as opened files in Word and Excel viewers, a media player, or 
Internet Explorer. 
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Recipe Management (15 minutes) 

Completing this section requires approximately 15 minutes. 

Why do you need to use recipes? 

A recipe is a set of numeric and string data values (ingredients) that can be downloaded /uploaded to 
their associated tags in a controller. Each ingredient has a pre-set data value assigned to it.  

The set of data values for all the ingredients in a recipe is called a data set.  

The set of numeric and string tags assigned to the ingredients in the recipe is called a tag set.  

The ingredients, data sets, and tag sets are stored together in a recipe file. 

You can create different pairs of data sets and tag sets for the same set of ingredients. Each pairing of 
data set with tag set is called a unit. Each unit is like a unique recipe.  

At run time, the operator can select the unit (recipe) that applies to the current operation.  

For example: A factory making soda could use the same ingredients and tag sets (tags in the controller), 
but depending on the flavor desired, could use different data sets to specify to use of certain flavor 
extracts. As another example, you might want to have multiple blending lines making the same soda. In 
this case, the data set for all the production lines will be the same, but the tags receiving the recipe 
information would be different for each production line. Units allow you to combine different tag sets and 
data sets for the same set of ingredients. 
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As you can see in this example there are 3 production lines. Line 1 is using its own Controller (PLC1), 
Line 2 and 3 are using the same controller (PLC2) but different tags.  Each line has its own set of tags 
which are grouped in a Tag Set. Each tag in the tag set is linked to an ingredient.  

In the recipe there are 3 different Data sets of soda flavors:  Blueberry, Grapefruit and Kiwi. 

Every data type within the data set is linked to an ingredient. 

These three data sets can be used by all the production lines because we use a Unit to combine a Tag 
Set and a Data Set 

 

The FactoryTalk® View RecipePlus system overview : 

Each recipe file can contain: 

− 15,000 ingredients 

− 500 data sets 

− 50 tag sets 

− 2,500 units (Combination of the data sets and tag sets) 

When using 1 production line (1 tag set) the maximum number of units is 500. 

 

Ingredients:   Type   Min  Max 
Water    Numeric 100 800 
Syrup   Numeric   10 100 
Flavor Extracts  String 

Data set : Blueberry  
Water:   200 
Syrup:   40 
Flavor extract:  Blueberry 

Tag set: Line1  
Water: PLC1: BlendingL1.water 
Syrup: PLC1: BlendingL1.Syrup 
Flavor extr.: PLC1:BlendingL1.FlExt 
 

Tag set : Line2  
Water: PLC2: BlendingL2.water 
Syrup: PLC2: BlendingL2.Syrup 
Flavor extr.: PLC2:BlendingL2.FlExt 
 

Tag set : Line3  
Water: PLC2: BlendingL3.water 
Syrup: PLC2: BlendingL3.Syrup 
Flavor extr.: PLC2:BlendingL3.FlExt 
 

Unit: Line1_Blueberry 

Unit: Line2_Blueberry 

UNIT 

RECIPE 

Data set : Grapefruit  
Water:   200 
Syrup:   60 
Flavor extract:  Grapefruit 

Data set : Kiwi  
Water:   200 
Syrup:   70 
Flavor extract:  Kiwi 

Unit: Line2_Grapefruit 

Unit: Line3_Grapefruit 

Unit: Line3_Kiwi 

DATA SET  TAG SET 
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Your factory is currently running 3 different types of Soda drinks. The sales of the Grapefruit soda are 
going so well they want a separate blending line to make this soda drink.  

The company has invested in a new blending line but they want to re-use the recipe from the original 
blending line. 

In this section you will: 

� Import and modify recipe models and understand the principles of Recipes. 

� Review a recipe screen using the standard Recipe Plus components. 

Open the InstantFizz Advanced application 

If you already have the InstantFizz Advanced application open from a previous section, you can move on 
to the next section, Error! Reference source not found.. 

1. To open FactoryTalk View Studio, click Start > All Programs > Rockwell Software > FactoryT alk 
View > FactoryTalk View Studio .  If FactoryTalk View Studio is already open, then select File > 
Open Application…  to switch applications. 

2. Select the existing InstantFizz Advanced  application, make sure English  is selected for the 
Language , and click Open : 

 

3. If you are switching applications you will be prompted to close the currently open application, click the 
Yes button to proceed. 
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Importing RecipePlus tags 

Recipes have two tag settings that are used to determine the results of various recipe operations during 
run time.  

The first tag is called the Status Tag and it shows the results of download, upload, upload and create, 
delete, rename, restore and save operations. The result status of these operations can be ‘start’, 
‘successful’ or ‘with errors’.  

The second tag is called the Percent Complete Tag. The recipe system writes to this tag during any 
recipe operation to show what percent of ingredients currently being processed have been completed.   

Before we can have a look at these tags we are going to import them. 

1. From the Tools  menu select the Tag Import and Export Wizard…  option. 

 

 

2. Select Import FactoryTalk View tag CSV files  from the drop down list and click Next . 

 

3. To the right of the Project  field, select the browse button . 

4. Double click the folder InstantFizz Advanced  and select InstantFizz Advanced.MED . 

5. Click Next  , you just selected which ME application you want to import the tags to. 

6. Click on browse button , now you are going to select the file that contains the tags that you are 
going to import. The file is located at: C:\Lab Files\ViewME – ViewPoint\ViewME\Pick and Cho ose.  
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7. Select the Recipe_Tags.csv  file and click . 

 

8. Once the CSV file has been selected click Next . 

 

9. You will be presented with an import options dialog.  In this case you can just leave it as default and 
click Next . 

Skip existing - Means that tags in the import file that are also in the database will not be imported 

Update existing - Means that the duplicate tags in the database will be updated with the info from the 
import file. 

Important : The import wizard will not delete any tags. If you want the remove tags you need to do that in the 
tag database builder itself. 

10. You will be presented with an overview of the source and destination files. Click Finish  to import the 
tags into the application. 

11. You will see a dialog box showing the status of the import; click the X in the upper right corner of this 
dialog to close it. 
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Checking the imported recipe tags 

Now you can go and verify the tags that you imported. 

1. Go to the folder, expand it and double click on . 

2. As you can see the 2 tags have been created for you. 

 

Status tag 

The status tag shows the results of recipe download and upload operations.  The following table indicates 
the value of the status tag (in hexadecimal) when certain operations are performed: 

Operation Start Successful With Errors 

Download 0x01 0x02 0x04 

Upload 0x011 0x012 0x014 

Upload and Create 0x021 0x022 0x024 

Delete 0x041 0x042 0x044 

Rename 0x081 0x082 0x084 

Restore 0x101 0x102 0x104 

Save 0x201 0x202 0x204 

Percent complete tag 

The recipe system writes to this tag during any recipe operation to show what percentage of ingredients 
currently being processed have been completed. 

Configuring the RecipePlus components  

The RecipePlus feature allows users to read or write a set of values to a set of tags in a single operation. 
RecipePlus can also be used to compare two recipes to determine their differences.  

The RecipePlus feature consists of several components: 

RecipePlus Setup  – used to specify whether recipe files will be a part of the HMI project, and where the 
files will be stored for retrieval at run time.  

RecipePlus Editor – used to create and edit the recipe files by specifying the ingredients of the recipe, 
the data sets, the tag sets and the recipe units. The editor can also be used to compare data sets and tag 
sets within a single recipe.  
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RecipePlus table object – used to display, modify and save the contents of a recipe at run time. The 
table also shows the differences between the recipe data values and the tags associated with the recipe 
(i.e. data set and tag set). 

RecipePlus button object – used to initiate recipe operations at run time (i.e. download, upload, upload 
and create, save, restore, delete and rename). 

RecipePlus selector object – used to select from a list of created recipes. 

Importing the Recipe into your application 

Since we are starting from an existing Blending Line we are going to import the recipe file. 

1. Right mouse click on RecipePlus Editor and select Add Component Into application…. 

 

 

 

2. Navigate to the C:\Lab Files\FTViewME – ViewPoint – PVP Pro\ViewME\ Pick and Choose  folder. 

3. Select the Soda recipe.rpp file and click Open . 

 

The recipe has now been imported into the application. 

Setting up RecipePlus 

1. Under select . 
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2. Make sure that the Recipe files are part of the HMI project  radio button is selected. 

 

At run time, recipe files can either be a part of the HMI project, or can be stored in some other location. Use 
the RecipePlus Setup dialog to specify where the recipe files will be located at run time. 

At design time, only recipe files that are within the HMI project can be edited. 

Important: If you choose to store the recipe files outside of the HMI project at run time, you must move the 
files manually from within the HMI project to the desired location before running the application. 

Recipe file location  

Recipe files are part of the HMI project 

Select this radio button if recipe files will be part of the HMI project at run time. Recipe files appear under the 
RecipePlus editor node in the Application Explorer. The recipe folder in the HMI project will be named 
RecipePlus. 

When this option is selected, all of the recipe files in the HMI project will be included in the ME runtime 
application (*.mer). This is the default behavior. 

Recipe files are NOT part of the HMI project 

Select this radio button to specify an alternative location for recipe files at run time. 

Click the browse button to browse to the desired location. At run time, the recipe system will look for recipe 
files in this folder rather than in the HMI project recipe folder. 

When this option is selected, none of the recipe files in the HMI project or in the specified folder will be 
included in the ME runtime application. 

 

3. Click  to close this screen. 

Adding a TagSet to a Recipe 

1. Under double click . This is the recipe file you just imported. 
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2. You will see the General  tab as shown below. 

 

General Tab: 

Runtime recipe name 

Type a unique, user-friendly name for the recipe file. This is the name the recipe selector will use at run 
time.  

Status tag 

Click the browse button to open the Tag Browser and specify a tag to be used as the status tag.  

Percent complete tag 

Click the browse button to open the Tag Browser and specify a tag to be used as the percent complete tag.  

The Status tag and Percent complete tag are not filled in.  

3. Click the browse  button  to the right of the Status Tag field. 

This will open the tag browser, highlight the InstantFizz Advanced  folder and select the StatusTag, 
click OK. 

 

4. Repeat step 3  above for the Percentage Complete Tag  field and this time select the 
PercentCompleteTag  tag. 

5. Click on the Ingredients  tab. 
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General Tab: 

Ingredient 

Type the name of the ingredient. Examples might be Sugar, Nitric acid, Secret sauce, 55mm carriage bolts, 
2x4 oak, etc. 

Type 

Specify whether the data value should be interpreted as a number or a string. 

If the type is Number, the value, if present, must be a valid integer or floating point number. 

If the type is String, the value, if present, can be any string. The Min and Max properties do not apply. 

Min 

If the ingredient type is Number, type the smallest value that can be written to the tag when the recipe is 
downloaded or the ingredient is edited in the table at run time.  

The possible range is -1.797693E+308 to 1.797693E+308. 

Max 

If the ingredient type is Number, type the largest value that can be written to the tag when the recipe is 
downloaded or the ingredient is edited in the table at run time.  

The possible range is -1.797693E+308 to 1.797693E+308. 

Data Set 

When a new recipe file is created, one data set is created, and named Data Set 1. To rename or delete this 
data set, or to insert a new data set, click the Recipe menu at the top of the FactoryTalk View Studio frame. 
Data set names can have a maximum of 31 characters. 

In the row for each ingredient, type the data value in the cell of the data set column. 

Tag Set 

When a new recipe file is created, one tag set is created, and named Tag Set 1. To rename or delete this 
tag set, or to insert a new tag set, click the Recipe menu at the top of the FactoryTalk View Studio frame. 
Tag set names can have a maximum of 31 characters. 

In the row for each ingredient, insert the tag name associated with the data value in the cell of the tag set 
column. You can type the tag names or select tags from the Tag Browser. 
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This is a list of all the ingredients that are needed to create Blueberry, grapefruit, kiwi or mango.  As you 
can see we only have 1 tag set which is called Tag Set 1 . 

6. If you click on the Units  you will see that the units are all linked to the Tag Set 1 . Now go back to the 
Ingredients  tab. 

7. Select the Recipe  menu option located between Edit  and View . 

  

8. In the pull down menu select Rename Tag Set…    

 

9. Enter ‘Blending Line 1 ’ in the Enter new tag set name:  field for Tag Set 1. 

 

10. Click OK to close the Rename Tag Set dialog. 

11. If you now click on Units  tab you will see that the tag set of the units is also modified.  Select the 
Ingredients  tab again. 

12. In the Recipe  pull down menu select Insert Tag Set… .  
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13. Enter ‘Blending Line 2 ’ in the Enter the name of the new tag set:  field. 

 

14. Click OK. 

15. For this new Blending Line 2  we need to fill in the associated tags using the tag browser 

16. To open the Tag Browser, select the top cell under the (Tag Set) Blending Line 2  column heading, 
right-click  in the cell and select Tag Browser , or select Tag Browser  from the Edit  menu. 

 

You will need to change the column widths  using the mouse in order to see the last column. 

17. Fill  in the tags for the Blending Line 2 as shown below: 

Water {::[PLC1]Program:BlendingL2.Recipe.Water} 
Syrup {::[PLC1]Program:BlendingL2.Recipe.Syrup} 
Acid {::[PLC1]Program:BlendingL2.Recipe.Acid} 
Carbon Dioxide {::[PLC1]Program:BlendingL2.Recipe.CarbonDioxide} 
Coloring {::[PLC1]Program:FillerD.ProductColor} 

18. Expand Recipe and select the Flavor  folder in the left hand pane of the tag browser for the Flavor  
ingredient tag. 

19. Select Flavor  and click OK.  Your Tag Set 2 column should look like this: 

 

In this case we are using the same controller but a different routine in the controller for the second 
blending line. The tag set could also come from a different controller. 
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18. Now select the Units  tab. 

 

Units Tab: 

Use the Units tab to pair tag sets with data sets to create recipe units.  

When a new recipe is created, a new recipe unit with the default name of Unit 1 is created, pairing the 
default data set Data Set 1 and the default tag set Tag Set 1. 

Click on a unit name to select it. You can then edit the selected unit, delete the selected unit, or insert a new 
unit at the bottom of the list. 

Unit name 

Click on a unit name to select the unit. The Data Set and Tag Set are automatically selected as part of the 
unit. 

Insert 

Click this button to open the Insert Unit dialog. 

Edit 

Click this button to open the Edit Unit dialog. 

Delete 

Click this button to delete the selected unit. 

In this lab, Blending Line 1 is making four different soda drinks Blueberry, Grapefruit, Kiwi and Mango. 
Now you will create another unit for Line 2 using the Grapefruit dataset. 

19. Select Insert  and enter ‘Grapefruit Line 2 ’ in the Unit name  field, use the drop down 
list buttons and select Grapefruit  and Blending Line 2  as shown below. 

 

20. Select OK  to close the  Unit  dialog. 

21. Select Close   in the RecipePlus Editor,  and select Yes  to save the recipe. 



165 of 254 
 

 
Now the unit is created so that it can re-use all the values used in the original line recipe for Grapefruit on 
the new Blending Line 2. 

View the existing recipe display  

1. In the application Explorer, expand Graphics  and Displays , then double-click on the 3A Filling - 
Recipes  display to open it: 

 

All of these objects have been configured for you and your display should look like: 

 

The 3A Filling – Recipes  display has been configured for you and is where at run time you can 
upload and download recipes, or lists of ingredients, view recipe contents, and select recipes to use. 
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2. Double-click on the RecipePlus Selector  object near the top of the display to view its configuration. 

 

This object allows you to select a recipe file and unit to be acted upon using the RecipePlus buttons 
described later on. 

 

3. Click Cancel when finished. 

4. Double-click on the RecipePlus Table  object in the middle of the display to view its configuration. 

 

This object is used to display and edit recipes during runtime. 
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5. Click Cancel when finished. 

6. Double-click on the Download  button in the bottom left hand corner of the display to view its 
configuration. 

 

The RecipePlus buttons  can be defined for any of the RecipePlus actions: Download, Upload, 
Upload and Create, Restore, Save, Delete and Rename. 
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7. Click Cancel when finished. 

8. Double-click Startup  in the application Explorer to configure startup options, check the Initial graphic 
checkbox if it isn’t selected already and verify that 1 Overview  is selected as the Initial graphic : 

 

9. Click OK to accept your changes.  

10. Make sure that you don’t have the project running from a previous section. If you do, click Shutdown  
or Exit  to close it.  

Testing the application 

To test the application you will use FactoryTalk Studio for Machine Edition’s Test Application  function.  
You can use the PanelView Plus, however, these instructions use Test Application . 

1. From the Application  menu, select the Test 
Application  item. 
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2. On the Select Languages  dialog, make 
sure that English  is selected as the initial 
runtime application language and click 
Finish . 

3. Click the Finish  button  to build the 
runtime application file. 

 

While the system builds the runtime MER, a 
progress dialog is displayed. 

 

When the runtime MER file is built, the system loads the runtime MER in to an emulation mode.  The 
application will appear in the upper left-hand corner of the computer display.  

4.  If you did not complete the Working With Security  section, skip to Step 5 .  If you have, you will 
need to log in with proper credentials.   

Click on Security , then Log In  and use the credentials of user name ‘Operator ’, 
password ‘Operator ’.   

5. Click the Recipes  button  to open the display. 

6. Use the different RecipePlus objects to upload and download recipes, view lists of ingredients or 
recipe contents, and select recipes to use. 

7. Exit   the application when you are finished. 

Congratulations!!  You have successfully configured RecipePlus and used RecipePlus objects on a 
display. 
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Working with security (15 minutes) 

Completing this section requires approximately 15 minutes. 

FactoryTalk View ME user accounts work with security codes to determine whether a user gets access to 
the system at run time. Each display in a project is assigned a security code. Users are also assigned 
security codes. At runtime, if a user is assigned access to the security code for a particular display they 
are allowed to access the display.  

When you set up security in FactoryTalk View ME, user accounts are stored in the FactoryTalk Directory. 
This means that those same user accounts can be used not only with the FactoryTalk View ME 
application, but with any other FactoryTalk-enabled software running on the same computer. You can add 
a FactoryTalk user account that is separate from a user’s Windows account, or a Windows-linked user 
account that inherits all the operating system user settings.  

FactoryTalk View ME security allows you to assign any one of 16 security codes (A-P), or an asterisk (*) 
to your displays. Users are also assigned security codes, and if a user’s assigned security codes match 
the code assigned to a display, they are allowed access to the display. All users are allowed access to 
displays with the asterisk for the security code. By default, new users have all 16 security codes assigned 
to them. The Default  user also has all 16 security codes assigned. The Default user account is used 
when no user is logged on.  

In this section you will: 

� Add a User and grant permissions to the 3A Filling – Recipes  display 

� Create and apply security to a User Group. 

Open the InstantFizz Advanced application 

If you already have the InstantFizz Advanced  application open from a previous section, you can move 
on to the next section, View the security code for a display. 

1. To open FactoryTalk View Studio, click Start > All Programs > Rockwell Software > FactoryT alk 
View > FactoryTalk View Studio .  If FactoryTalk View Studio is already open, then select File > 
Open Application…  to switch applications. 
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2. Select the existing InstantFizz Advanced  application, make sure English  is selected for the 
Language , and click Open : 

 

3. If you are switching applications you will be prompted to close the currently open application, click the 
Yes button to proceed. 

 

View the security code for a display 

1. In the application Explorer, expand Graphics  and Displays , then double-click on the 3A Filling - 
Recipes  display to open it: 
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The display is opened: 

 

The 3A Filling – Recipes  display is where at run time you can upload and download recipes, or lists 
of ingredients, view recipe contents, and select recipes to use.  

2. Select Display Settings  on the Edit  menu. The Display Settings editor for the 3A Filling – Recipes  
display is opened: 

 

The Display Settings editor is where you can specify a security code for a display. Note that the 3A 
Filling - Recipes  display is assigned Security Code A. Click Cancel  to close the dialog.  

Create a new user account and assign security codes  

1. Since the display has a security code of A, you will now create a new user account called “Operator ” 
that is assigned the same security code. Double-click Runtime Security  in the application Explorer to 
launch the Runtime Security editor: 
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2. As mentioned earlier, the Default  user has all 16 codes assigned by default. First remove security 
code A from the Default user so that only users assigned security code A can access the 3A Filling – 
Recipes display. Select the Default  user and click to uncheck the checkbox for security code A as 
shown below. You then need to click Accept  to apply the change. 

 

Note that on this screen and in the steps below, you may see different users or user groups from 
what is shown.  

3. Click the Add  button  to add a new user account. The Select User or Group  dialog is 
shown; select Show users only : 
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4. Click Create New  and select User :  

 

5. On the General  tab, enter ‘Operator ’ as the User name . Check Password never expires . Enter 
‘Operator ’ as the Password  and confirm it in the Confirm  box.  

 

6. Click OK to add your new user. The Operator  user should now show up in the list on the Select User 
or Group  dialog.  

7. Select the Operator  user account and click OK. The user is added to the Runtime Security user 
account list. Because new users by default are granted access to all 16 security codes, the Operator  
user is already assigned the security code A. This is what you want, so leave the security settings as 
they are.  
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8. Click Close  to close the Runtime Security  editor. Click Yes when you are asked if you want to save 
the changes: 

 

You have now created a new user and configured security for it. Remember that you will need to login to 
the application as user Operator  from now on when running the application if you want to access the 3A 
Filling – Recipes  display.  

Exercise security 

The following steps show you how to log in as user Operator  when the application is running. Try 
accessing the 3A Filling – Recipes  display before and after you log in as Operator  to observe what 
happens when you do not have rights to a display. Remember that the password for the Operator user is 
‘Operator’. 

1. Double-click Startup  on the application Explorer to configure startup options, check the Initial 
graphic checkbox if it isn’t selected already and verify that 1 Overview  is selected as the Initial 
graphic : 
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2. Click OK to accept your changes.  

3. Make sure that you don’t have the project running from the previous section. If you do, click Exit  to 
close it.  

4. On the Application  menu, click Test Application .  

 

5. Select English  as the initial runtime language and click Finish .  
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The runtime file is created. You will see progress bars while it is compiled, and when it is complete 
the application will run. It will take a couple minutes. 

6. When the application starts, the Overview screen is shown, and you can see that the logged in user is 
‘DEFAULT ’: 

 

7. Because you are logged in as Default, you should not have security rights to the 3A - Filling Recipes  
display that you configured security for. (Remember that the display is assigned security code “A”, 
and the Default user does not have access rights to “A”.) Click the Recipes  button to see what 
happens: 

 

You should see an error saying access is denied because the currently logged in user does not have 
security access to the display. You can click Close  to close the error display.  

8. Now you will log in as the Operator  user you created, and who does have security access to the 3A – 
Filling Recipes  display. Click the Security  button on the bottom toolbar.  

 

9. A second toolbar is displayed. Click Log In : 

 

The Login  display is opened.  Click the User (F2)  button and use the keyboard to enter ‘Operator ’. 
Click the Password (F3)  button and enter ‘Operator ’ for the password. It should look like this:  

 

Click the enter button  to log in.  
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10. Click Close  to close the Security menu.  

 

11. Now click the Recipes  button to see what happens. 

 

The recipes screen is opened, because as the Operator  user you have security access rights! 

NOTE: You may see errors that an item is no longer available if the Recipe Management section 
has not yet been completed.  You will notice that the Operator  user successfully opened this display 
however, the recipe objects are blank. 

12. Click the Close  button  to close the recipes display. 

13. Click Exit    to close the running application.  

Using security groups 

Just as you assign security rights to a user account, you can also create user groups, include users in 
those groups, and assign security rights to the group as a whole. Any security rights that are applied to 
the group will apply to each user account in the group.  

In this section you will add user accounts to a group and configure security for the group.  

1. Double-click Runtime Security  in the application Explorer to launch the Runtime Security editor: 

  

2. Click the Add  button to create a new user group: 
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3. Click Create New , then User group  to create a new group.  

 

4. On the New User Group  dialog, enter ‘Managers ’ for the group Name.  

Click Add  to add users to the new group: 
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5. Click Show users only  to see the list of configured users. Hold down the Ctrl  key and click the 
PlantManager  and ShiftManager  users to select them.  

 

6. Click OK to add the users to your group. They should show up in the New User Group  dialog in the 
Members  list: 

 

7. Click OK to create the new user group with group members PlantManager  and ShiftManager . The 
Select User or Group  dialog will list your new group: 
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8. Select the Managers  group and click OK. The Managers group is now ready for you to configure 
FactoryTalk View ME security: 

 

You can tell a group from a user in the Runtime Security list by the square brackets around a group 
name.  

You cannot manage users and groups, other than creating a new user or group, from the FactoryTalk View 
Studio Runtime Security editor. If you want to add users to an existing group or delete users you must use 
the FactoryTalk Administration Console  or the Users and Groups editor found in the SYSTEM area of the 
FactoryTalk View Studio application Explorer.  
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9. Select the [Managers] group in the Account list. Because it is a new group, it has access rights to all 
of the A-Z security codes. Leave the account rights as they are.  

User groups are highly recommended because they allow you to simplify the configuration of security 
rights. With user groups you can create groups for the different types of users (for example, 
“maintenance” or “operators”), add a particular user to the appropriate user group, and configure 
security rights for all users in that group at once, rather than having to configure rights individually.  

Because you allowed the Managers  group security rights to displays with security code A, both the 
PlantManager  and the ShiftManager  user will be able to access any displays assigned code A.  

10. Click the Close  button to close the runtime security editor. Click Yes to save your changes.  

When you backup a FactoryTalk View ME project to an .APA file, the users you have created in the 
FactoryTalk Directory and configured security for are backed up along with the displays and other project 
data. When you restore the application, you are asked whether you want to restore the FactoryTalk Local 
Directory.  If you answer “Yes”, the backed up FactoryTalk Local Directory is restored to the new 
FactoryTalk Directory, and overwrites the Local FactoryTalk Directory on the machine. If you answer “No” 
and do not restore the backed up FactoryTalk Directory to the new PC, you will see that in the Runtime 
Security editor, the usernames are listed in CLSID format, which is an alphanumeric display. If you have 
done this, refer to Answer ID 38817  in the Rockwell Automation technical support database for an 
explanation and workaround.  

Testing the application on desktop 

1. Click Test Application  on the Application  menu to compile and run it.  

2. Click on Recipes   to access this display.  Because you are automatically logged in as Default, 
you should not have security rights to the 3A - Filling Recipes  display that you configured security 
for.  

You should see an error saying access is denied because the currently logged in user does not have 
security access to the display. You can click Close  to close the error display.  

3. Click on Security , then Log In  to enter the credentials of any of the Users that were 
added to the Managers User Group. 

Note that the user passwords are the same as the login; for example, the ShiftManager user has a 
password of ‘ShiftManager’. 

4. Click on Recipes   to access this display once again and you should now have access since 
the ShiftManager  and PlantManager  users were given security rights under the Managers group. 

5. Click Exit  to close the running application when you are done.  

Congratulations!! You have successfully created a User and User Group, assigned security codes to 
them and tested the functionality of security in your application. 
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Additional Alarming Features (20 minutes) 

Completing this section requires approximately 20 minutes. 

By default, the Alarm Banner only shows the operator the most current alarm.  This is not always a good 
fit for an application.  The Alarm Banner has additional capability to queue incoming alarms while an 
unacknowledged alarm is being displayed.  Once the operator acknowledges the first alarm, the 
subsequent alarms must be acknowledged in turn.  While this provides more capability, it still may not 
meet an application’s needs.  The final alarm capability is an Alarm History object that displays multiple 
alarms in different states.   

In this section, you will configure the Alarm Banner to queue incoming alarms and add an Alarm History 
display to the application you have built. 

In this section you will: 

� Configure the Alarm Banner to queue incoming alarms. 

� Add and configure an Alarm History object. 

� Exercise the Alarm History on a PanelView Plus terminal. 

Open the application 

Chapter 2 had you create a simple alarm system using the default Alarm  display and Alarm Banner  
object.  An application called Chapter2_Complete is available for you.  Follow the steps below to open 
the application. 

1. To open FactoryTalk View Studio, click Start > All Programs > Rockwell Software > FactoryT alk 
View > FactoryTalk View Studio .  If FactoryTalk View Studio is already open, then select File > 
Open Application…  to switch applications. 

2. Select the existing Chapter2_Complete application, make sure English  is selected for the 
Language , and click Open : 
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3. If you are switching applications you will be prompted to close the currently open application, click the 
Yes button to proceed. 

 

Adding an Alarm Summary 

1. Double-click on the [ALARM]  display in the Displays  container to open it. 

 

2. Double-click the Alarm Banner  object to open its properties dialog 

 

3. Click on the Alarm  tab in the Alarm Banner Properties  dialog to activate. 

4. Enable the Queue new alarms  option by clicking in its checkbox. 

 

5. Click the OK button  to complete the Alarm Banner  configuration. 
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6. Close the [Alarm]  display; click Yes button  when prompted. 

 

You will next use another FactoryTalk Studio for Machine Edition capability to add existing content in an 
application.  In addition to XML file import/export, application graphics can be reused between 
applications.  FactoryTalk Studio for Machine Edition includes several useful graphics for alarms, 
diagnostics and information display. 

7. Right-click the Displays  item in the Project Explorer and select the Add Component Into 
Application  item. 

 

This opens the Add Component Into Project  dialog. 

8. Navigate to the C:\Lab Files\ViewME - ViewPoint\ViewME\Pick and Cho ose  folder 

9. Double-click on the [L15 History] 640x480.gfx  file to select it, and close the dialog. 

The system begins adding the selected display to 
the current application.  The following Migrating 
Data dialog displays while this operation occurs. 

 

When complete the dialog closes.  The Displays  
container in the Project Explorer  updates to 
display the newly added display. 
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10. Double-click the [L15 History] 640x480  to view. 

 

There are no changes required on this display. 

11. Close the [L15 History] 640x480  display. 

12. Double-click the Main  display to open. 

13. Select the Goto  object from the Objects > Display Navigation  menu. 
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14. Find an empty area on the Main  display; 
click and hold while dragging downward 
and to the right to create a Goto Display  
button. 

15. Double-click the Goto Display  button to 
open its properties dialog. 

 

16. On the General  tab find the Display:  
textbox and click the Browse  button . 

This opens the Component Browser  
dialog. 

 

17. Select the [L15 HISTORY] 640x480  item. 

18. Click the OK button  to complete 
the selection. 
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19. Click the Apply  button  to commit the 
change. 

 

20. Click the Label  tab to activate it.  

21. Enter ‘Alarm Summary ’ in the Caption  field. 

 

22. Click the Apply  button  to commit the caption change. 

23. Click on the Common  tab to activate it. 

24. Change the Height, Width, Top,  and Left  fields to size and position the Goto Display Button 
Properties  exactly. 

Height 68 

Width 104 

Top 400 

Left 130 

 

 

 

This change will position the button from the location you drew it on the display to match the position 
and size of the other navigation buttons at the bottom of the Main  display. 

25. Click the OK button  to commit the change and close the dialog. 
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The Main  display now should look something like this. 

 

26. Close the Main  display; click the Yes button  to save your changes when prompted. 

 

Testing the Alarm Summary 

To test the new AlarmSummary  navigation button and changes to the Alarm Banner  you need to create 
a runtime MER and download to a PanelView Plus terminal. 

1. Select Create Runtime Application  from the Application  menu. 

 

2. Use the default file name of Chapter2_Complete.mer  and verify that the Save as type  field is set to 
Runtime 6.0 Application (*.mer).  
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3. Click the Save button to begin runtime application creation. 

4. After a few moments a progress dialog, Creating runtime file , will appear.  This dialog lets you 
monitor the creation process. 

 

When the runtime application is completed, the dialog will close automatically. 

5. To download the runtime MER to the PanelView Plus 1000 terminal at your workstation, first, select 
the Tools > Transfer Utility  menu item 
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The Transfer Utility will open. 

 

6. Click the Source File  browse button  to select the runtime MER file to download. 

 

This opens the Select File to Download  dialog. 

 

7. Double-click the Chapter2_Complete.mer  file to select the runtime application and close the dialog. 

8. Double-click the EtherNet, Ethernet  driver  to expand the item. 
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9. Select the 192.168.1.20, PanelView Plus CE_6 1000, PanelView P lus CE_6 1000  item by clicking 
on it once. 

10. To initiate the download process, click the Download  button  

During the download, a progress dialog will update. 

 

When the download process completes a confirmation dialog is shown. 

 

11. Click the OK button  to acknowledge the dialog. 

12. Click the Exit  button  to close the Transfer Utility. 

Execute the following steps to run the downloaded runtime application Chapter2_Complete.mer  

13. Move over to your PanelView Plus terminal. If FTView ME Station  is not already running, start it by 

double-tapping the icon on the desktop:  
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14. Press the Load Application [F1]  button. 

 

15. Select the Chapter2_Complete.MER  file from those available from the terminal’s Internal Storage. 

 

16. Press Load [F2]  to load the runtime file in to memory. 

17. When prompted, press Yes [F7]  to overwrite the terminal’s current communication configuration with 
the configuration contained within the L15.MER file. 

18. Once successfully loaded, press the Run Application [F2]  to start executing the runtime file. 

 

While the terminal is starting the application, an update dialog is displayed. 

 

After the start-up processing completes you should see your applications initial display, similar to the 
one below: 
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To observe the differences in the Alarm Banner  configuration and the new Alarm Summary, execute the 
following steps: 

19. Tap the Start Process  button , if the process is not already running.  If the process is 
running the button caption reads ‘Stop Process’ and the button color is red. 

20. Tap the Flow Rate  button  and enter a value of ‘15’ and press Enter . 

21. Tap the Start  button.  

The pump will fill with a green shaded fill to show that the pump is running.  After about 10 seconds 
an alarm ‘Tank 1 Low Flow Rate’ will occur. 

22. Tap the Close [F4]  button to close the Alarm Banner  without acknowledging the alarm. 

23. Quickly , Tap the Flow Rate  button, enter a value of ‘245’, and press Enter . 

After about ten seconds an alarm ‘Tank 1 Flow Obstructed’ will occur. 

After approximately another ten seconds a new alarm ‘Tank 1 High Flow Rate’ will occur but you will 
only be able to see this next alarm after you Clear  the previous alarm since the Alarm Banner is now 
configured to queue alarms. 

24. Tap the Clear Alarm [F3]  button for the ‘Tank 1 Flow Obstructed’ alarm. 

25. Now, the ‘Tank 1 High Flow Rate’ alarm is visible and can be acknowledged by tapping 
Acknowledge [F1] . 

26. Tap the Close [F4]  button to dismiss the Alarm Banner  without acknowledging the alarm. 
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27. Tap the Flow Rate  button, enter a value of ‘100’, and select Enter . 

This returns the flow rate to a level that will not generate additional alarms. 

28. Tap the Alarm Summary  button to open alarm summary display 

 

On the display, you can observe, at minimum, the last three alarm conditions that occurred. 

 

You can use the Up  and Down   buttons to move among the items in the Alarm History. 

29. Highlight the remaining unacknowledged alarms and tap the Ack Alarm  button . 

30. Tap the Close  button to close the Alarm History  display. 

31. Tap the Stop Process  button on the Main  display. 

32. Tap the Shutdown  button to terminate the application on the PanelView Plus terminal. 

Congratulations!!   You have successfully reused an alarm history component in your existing 
FactoryTalk View Studio for Machine Edition application, added display navigation, created a runtime file; 
and, exercised the application on a PanelView Plus terminal. 
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Language Switching (20 minutes) 

Completing this section requires approximately 20 minutes. 

Language switching is a FactoryTalk View Machine Edition application feature that allows the HMI 
designer to create a single runtime application that can display operator information in several different 
languages.  Consider an OEM that ships the same machine to North America, Germany, Italy, and China; 
is it more efficient to design and maintain a single HMI application for the global market, or an application 
per country.  You will be working with the existing application, InstantFizz Advanced, to help illustrate how 
designers implement an HMI application that uses language switching, and how the language switching 
works at runtime. 

In this section, you will: 

� Learn how to import and export the application’s text strings for translation 

� Add Language Switching buttons to the application 

� Test language switching using the desktop emulator 

Open the InstantFizz Advanced application 

If you already have the InstantFizz Advanced application open from a previous section, you can move on 
to the next section, Configuring the application for multiple languages.  

1. To open FactoryTalk View Studio, click Start > All Programs > Rockwell Software > FactoryT alk 
View > FactoryTalk View Studio .  If FactoryTalk View Studio is already open, then select File > 
Open Application…  to switch applications. 

2. Select the existing InstantFizz Advanced  application, make sure English  is selected for the 
Language , and click Open : 

 

3. If you are switching applications you will be prompted to close the currently open application, click the 
Yes button to proceed. 
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Configuring the application for multiple languages 

1. Using the Tools  menu select the Languages…  item 

 

This opens the Language Configuration. 

 

2. To add additional language entries in the list, click the Add  button .  This opens the Add 
Language  dialog. 
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3. In the Language  column locate the entry Chinese (PRC) ; double-click to add to the Language 
Configuration  dialog. 

 

4. Repeat Steps 2 and 3 to add German (Germany)  and Spanish (International Sort)  to the 
Language Configuration  dialog.  When you have successfully completed this task the Language 
Configuration  dialog will look like the example below. 

 

5. Click the OK button  to commit the changes. 

6. Next, you need to add several 
flag images to the application.  
To do this right-click the 
Images  item in the Project 
Explorer Graphics  folder, and 
select the Add component to 
application  item. 
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7. Navigate to the 
C:\Lab Files\ViewME - 
ViewPoint\ViewME\Pick and 
Choose  folder. 

8. Multi-select the three bitmap 
(*.bmp) files located in the 
folder. 

9. Click the Open  button  
to add the bitmap files to the 
application. 

 

During the addition process, a progress dialog is shown.  When completed, the Migrate Data  dialog 
will close 

 

Please expand the Images  item and 
verify the bitmap files have been added 
to the project. 

 

You may collapse the Images  item 
when you are done. 
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Adding Language Switch Buttons to the Application 

1. Expand the Displays  item, and open 
the display 0B Languages .  

2. Using the Objects  menu, select the 
Advanced > Language Switch 
Button  item. 

 

 

3. Draw a small Language Switch Button  on the 0B Languages  display. 

 

4. Double-click the Language Switch Button  to open its properties dialog. 

5. On the General  tab, change the 
Border Style to None , Back 
Style  to Transparent  and the 
Language  property to Spanish 
(International Sort)  using the 
dropdown. 

6. Click the Apply  button  to 
commit the change 

 

 



 

201 of 254 
 

7. Click the Label  tab to activate it 

8. Enter ‘Spanish ’ in the Caption  
field, change the Caption color 
to Black  and select Bold. 

9. Also change the Alignment  
grid, to center-bottom alignment, 
by clicking the radio button 
located in the center-bottom. 

Be sure to modify the 
Alignment  grid associated with 
the Caption , and not the Image 
Settings . 

 

10. Click the Browse  button located 
by the Image  textbox. 

This opens the Image Browser  
dialog. 

 

11. Select the Flag_of_Spain.bmp  
file. 

12. Click the OK button  to 
use the selection. 

 

14. Click the Common  tab to 
activate it. 

15. Change the Size and Position  
as follows: 

Height 65 

Width 60 

Top 2 

Left 200 
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16. Click the OK button  to complete the Language Switch Button  configuration.  The 
Language Switch Button  should now be located on the display as shown. 

 

To save time in the lab, you will now import two additional Language Switch Buttons  from an XML file. 

17. Save the 0B Languages  display using the toolbar tool , or the File > Save  menu command. 

18. Close the 0B Languages  display. 

19. Right-click on the Displays  item in the Project Explorer , and select Import and Export…  

 

This opens the Graphic Import Export Wizard dialog 

20. Select Import graphic information  
into displays  item 

21. Click the Next  button . 
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22. There is no need to backup the 
display that will be modified during 
the import.  Select No item, and click 
the Next  button . 

 

23. Select Single display import file  
item, and click the Next  button 

. 

 

24. You must select the file to be 
imported.  Click the Browse  button 

. 

 

This opens a standard Microsoft 
Windows File Open dialog. 

25. Navigate to the C:/Lab Files/ViewME 
- ViewPoint/ViewME/Pick and 
Choose  folder. 

 

 

26. Select the file Language Switch buttons (DEU and ZHN).xml  

 

27. Click the Open  button . 
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28. Using the dropdown Select the 
display to import to  list, select the 
display named 0B Languages .  
This is the display, to which the 
content must be added. 

 

 

29. The When importing  option should remain unchanged.  The default setting Create new objects on 
the display  adds unique objects to the display during the import operation; it does not overwrite or 
update existing objects. 

30. Click the Finish  button  to begin the process. 

When the process completes a results file is displayed. 

 

31. Close the results file. 

32. Open the 0B Languages  display from the Project Explorer . 

 

Two new Language Switch  buttons have been added to the display - one for German and one for 

Chinese.   

33. Close the 0B Languages  display. 

Exporting HMI Application Strings 

The last step in localizing an HMI application is translating the text strings the operator will see at runtime.  
The localization process occurs outside the FactoryTalk Studio for Machine Edition application.  Few 
designers would have the resources to translate their HMI application strings in-house.  Most will use an 
outside agency to perform the string translation.  Thus, the first step in localizing an HMI application is to 
export the application strings. 

Please note that the localized strings displayed to the operator are only those contained within the HMI 
application.  If the HMI application is displaying string data contained within a controller tag, those characters 
will be shown exactly as they are stored in the control system regardless of the current HMI application 
language setting. 
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1. Using the Tools  menu select the Languages…  item 

 

This opens the Language Configuration. 

 

2. Click the Export…  button. This opens the next wizard dialog. 

3. Select the Export strings for 
all languages to an Excel 
spreadsheet  and check the 
Open exported file  checkbox 
to automatically open the 
exported file. 

4. Click the Next  button  
to proceed. 
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5. Click the Browse  button  to 
change the default location. 

6. Navigate to C:\Lab 
Files\ViewME – ViewPoint. 

7. Select the ViewME  folder. 

8. Click the OK button  
to use the selection. 

 

9. Click the Finish  button 
 to export the strings. 

After a few moments the 
String Export in Progress  
dialog will appear.  This dialog 
allows you to monitor the 
export. 

 

 

Depending on how many languages the application is configured for, and the time required to perform 
the export, you may also see this dialog. 

  

When the export process completes the progress and information dialog(s) will automatically close 
and your exported file will open in Microsoft Office Excel 2007 since we chose that option earlier. 
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10. For informational purposes, a snapshot of the opened file appears below.  You do not need to any 
work in this file.  A different file has been prepared that contains all the translated strings. 

 

11. When you are finished viewing the file, close Microsoft Office Excel 2007 . 

Importing Localized HMI Application Strings 

To import the fully translated file execute the following steps. 

1. On the Language 
Configuration  dialog, click 
on the Import…  button 

 

 

3. Select the Import strings 
from an Excel  spreadsheet 
into all application 
languages defined in the 
spreadsheet  item. 

4. Click the Next  button 
 to proceed. 
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5. Click the Browse  button  
to change the default 
location. 

 

 

6. Navigate to C:\Lab 
Files\ViewME - ViewPoint\ 
ViewME\Pick and Choose  
folder. 

7. Double-click the 
TRANSLATED InstantFizz 
Advanced.xls  file to select 
and close the dialog. 

 

Confirm that you selected the 
corrected file TRANSLATED 
InstantFizz Advanced.xls . 

8. Click the Finish  button 
 to import the strings. 

After a few moments the 
String Import in Progress  
dialog will appear.  This 
dialog allows you to monitor 
the export. 

. 

 

When the import process completes, the progress dialog will close automatically close the progress 
window.  The Status Bar  reports “String import completed successfully”.  If errors occur a results file 
will be automatically opened on your workstation. 
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9. Click the OK button  to proceed. 

 

10. Double-click Startup  in the application Explorer to configure startup options, check the Initial graphic 
checkbox if it isn’t selected already and verify that 1 Overview  is selected as the Initial graphic : 

 

11. Click OK to accept your changes.  

12. Make sure that you don’t have the project running from the previous section. If you do, click 
Shutdown  or Exit  to close it.  

 

Testing the localized application 

To test the localized application you will use FactoryTalk Studio for Machine Edition’s Test Application  
function.  You can use the PanelView Plus, however, these instructions use Test Application . 
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1. From the Application  menu, select the Test 
Application  item. 

 

 

Since the application has been configured to 
support multiple languages, your need to 
select which languages to include in the 
runtime application; a total of twenty can be 
selected. 

2. Select all six languages. 

3. Click the Finish  button  to build the 
runtime application file. 

 

While the system builds the runtime MER, a 
progress dialog is displayed. 

 

When the runtime MER file is built, the system loads the runtime MER in to an emulation mode.  The 
application will appear in the upper left-hand corner of the computer display.  
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4. Click the Languages  button to open its display. 

 

5. Click on Español  to change the application language to Spanish.  Note that the caption for 
our Spanish  button was updated during the import with ‘Español’ to keep consistent with the other 
buttons where each caption is displayed in the native language. 
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6. Click the Deutsch  button  to change the language to German. 

 

This application provides a good example of a situation that engineers designing multi-language application 
must consider.  If you look at the text displayed on and within different objects, you will notice that the space 
required varies depending upon the language selected. 

 

 

Some objects may not be wide enough to contain the characters on a single line.  Although the objects are 
properly sized for English during development, when translated many text strings require more space as 
they contain more characters than the English-version of the same string. 

Congratulations!!  You have successfully localized your FactoryTalk View Machine Edition application, 
added language switching buttons, exported the English language strings, imported the translated strings, 
created a runtime file; and tested the application at your workstation. 
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Improving productivity with parameter passing (30 minutes) 

Completing this section requires approximately 30 minutes. 

FactoryTalk View ME allows the use of tag placeholders so that you can create one display that can 
represent a number of similar operations, simply by passing in different tag values.  

A tag placeholder is used to mark where you want to insert a tag name of some part of a tag name at run 
time. A tag placeholder is a crosshatch character (#) followed by a number from 1 to 500.  

Tag placeholders are used in FactoryTalk View ME by parameter files . A parameter file is a user-created 
text file that lists a number of tag placeholders that can be referenced in the project. The parameter file is 
part of a FactoryTalk View ME project. 

FactoryTalk View ME also supports the use of parameter lists . A parameter list is a list of tag 
placeholders specified for use on a particular display.  

Parameter lists can be used in the same components where parameter files can be used: 

� The graphic display that opens when an application is first run. Specify the graphic display to open, 
and the parameter file or parameter list to use with it, in the Startup editor.  

� Graphic displays that are opened using Goto Display buttons or Display List Selectors. Specify the 
graphic display to open, and the parameter file or parameter list to use with it, when you set up the 
button or selector.  

� Global Connections. Parameter files or parameter lists can be used with Remote displays.   

Parameters can be carried forward, or passed, to secondary displays that are linked to and open from the 
initial display, using either a parameter file or a parameter list. When a graphic display opens at run time, 
FactoryTalk View ME substitutes the string specified in the parameter file or the tag(s) specified in the 
parameter list for the tag placeholders in the graphic display. The same set of tag placeholders can then 
be passed on to a secondary display that is opened from the initial display.  

In this section you will: 

� Look at how Process Faceplates can take advantage of parameter lists to carry tags forward to 
subsequent displays.  

Open the InstantFizz Advanced application 

If you already have the InstantFizz Advanced application open from a previous section, you can move on 
to the next section, Add the PIDE faceplates . 

1. To open FactoryTalk View Studio, click Start > All Programs > Rockwell Software > FactoryT alk 
View > FactoryTalk View Studio .  If FactoryTalk View Studio is already open, then select File > 
Open Application…  to switch applications. 

2. Select the existing InstantFizz Advanced  application, make sure English  is selected for the 
Language , and click Open : 
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3. If you are switching applications you will be prompted to close the currently open application, click the 
Yes button to proceed. 

 

Add the PIDE faceplates 

You will use the Enhanced PID Process Faceplates supplied by FactoryTalk View ME to work with carry 
forward parameters. These faceplates must be added to the project.  

1. In the application Explorer, right-click the InstantFizz Advanced HMI Server and select Add 
Process Faceplates : 

 

The Add Process Faceplates dialog is opened. 

2. Click Clear All  on the Add Process Faceplates dialog: 
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3. Click the Enhanced PID – PIDE  check box and click OK.  

 

When faceplates are added to a project, displays and global objects are imported that can be used in 
the project. 

4. The 12 What is new  display in the InstantFizz Advanced project contains a Goto display button that 
is configured to open the Logix_PIDE display on the startup. Double-click the 12 What is new  display 
in the application Explorer under Displays  to open it: 
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5. On the display, double-click the Process Faceplates with Carry Forward Parameters  Goto display 
button (as shown above). The button’s property dialog is opened. Note the Display  and Parameter 
list  properties: 

 

The display specified by the Display  property is the display opened when the Goto display button is 
clicked at run time. In this case it is the Logix_PIDE  display.  

The value for the Parameter list property is: 

 {::[PLC1]Program:Fermenter_Temp.Tank_PIDE01} 

This value is a tag name that is “passed” to the Logix_PIDE display when it is opened. Passed tags 
can be referenced on the display.  

Click OK to close the property dialog.  

Testing the PIDE faceplates 

Now you will run the application in test mode and observe how parameter passing works with the PIDE 
faceplates. First you must set the initial display graphic.  

1. Double-click Startup  in the application Explorer to open the startup utility.  
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2. For the Initial graphic, select 12 What is new  and click OK.  

3. On the Application  menu, click Test Application . 

 

Verify that only English  is checked to include in the runtime application, and that English  is selected 
as the initial run time language.  

 

4. Click Finish  to create the runtime application. The runtime is created, then the application starts 
using the initial display you selected: 

 

5. Click the Process Faceplates with Carry Forward Parameters  button to open the Logix_PIDE 
display.  
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6. Click the Operator  button to put the PIDE into Operator mode. When it is in Operator mode, the 
button will appear disabled (grayed out).  

 

7. Click the SP (Set Point) numeric input, as shown above. The numeric input keypad is displayed: 

 

The keypad can be configured to include helpful information like the tag name and its minimum and 
maximum value.  We will do this in the next section. 

8. Click the ESC (Escape) key to close the keypad. 



 

219 of 254 
 

Investigate the numeric input configuration 

You will now look at how the Process Faceplates are configured to use the parameter passing, numeric 
input keypad and global objects.  

1. Click the FactoryTalk View Studio  item in the Windows taskbar to bring Studio to the front (you can 
leave the application running).  

 

2. When you import Process Faceplates, both Global Objects and Displays are brought into the project. 
The numeric input object is configured on the Logix_PIDE Global Object.  

In the application Explorer tree, double-click on Logix_PIDE  under Global Objects . 

 

3. Double-click on the SP numeric input object to open its properties. You may need to double-click a 
few times to get to the numeric input.  
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4. On the Numeric  tab, click Insert Variable > String  button under the Caption on 
keypad/scratchpad  field: 

 

5. To configure the numeric input keypad caption to include the tag name of the passed parameter, you 
use the Literal string  option. In this example, we will fix the number of characters to 11, and choose 
the option Right-most characters in string are displayed , since the full tag name is too long to fit 
on the numeric input keypad.  

 
 
Click OK to close the dialog. 

6. On the Numeric  tab you can also configure how the numeric input keypad displays the minimum and 
maximum for the tag value you are entering. You can either enter a value for minimum and maximum, 
or use a variable minimum and maximum. In this case, we want to use the variable minimum and 
maximum.  Select the Use variable minimum/maximum  checkbox to do so. 

 

7. When using a variable minimum and maximum, you need to specify the tags to be used.  Open the 
Connections  tab. 
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8. Double-click in the Tag / Expression field for the Minimum property and enter ‘{#1.PVEUMin} ’. 

9. Now double-click in the Tag / Expression field for the Maximum property and enter ‘{#1.PVEUMax} ’. 

Your Connections tab should look like this: 

 

9. Click OK to close the numeric input properties dialog. 

Investigate “carry forward” parameters 

You will now look at how parameter lists and parameter files support “carry forward” parameters. 

1. Click the FactoryTalk View ME Sod…  item in the Windows taskbar to bring the running application 
to the front. 

 

2. On the Logix PIDE faceplate, click the Trend  icon as shown below to open another display, 
Logix_PIDE_Trend . 

 

When the Trend faceplate is opened, you may see a diagnostic error message. If you do, click the 
Close [F5]  button. The display should show valid data. 
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3. Now open a secondary Ontop display from the Trend (Logix_PIDE_Trend) faceplate. Click the 
AutoTune  button as shown below:  

 

When the AutoTune faceplate is opened, note the errors shown in the diagnostic window, and that 
the AutoTune display does not have valid data.  

4. Click the Shutdown Demo  button to close the test application. 
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Fixing the PIDE faceplate errors 

You will now explore the PIDE faceplates and determine why you are getting errors at run time. You will 
look at how parameters are passed from one display to secondary faceplates or displays and fix any 
problems you find. 

1. Expand the Diagnostic list in FactoryTalk View Studio so you can see a number of entries, as shown 
below:  

 

Scroll down the list to see the errors that are there. Error messages display this icon: . 

Note that most of the errors say that an “Expression contains a tag that has an error value.”, and 
display the expression with the error. You might notice that all of the expressions listed reference the 
#2 tag placeholder. This most likely indicates that there is a problem with the second tag reference 
being passed somewhere between the initial display and the AutoTune display. In the next steps you 
will look at the parameter passing configuration and try to find the problem.  

2. The last diagnostic errors you saw were generated on the AutoTune, or Logix_PIDE_AutoTune 
display. This display is generated from a Global Object imported with the PID faceplates, so you will 
need to explore how the faceplate Global Object gets its data. Double-click Logix_PIDE_AutoTune  
under Global Objects  in the application Explorer: 
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The Logix_PIDE_AutoTune Global Object is opened:  

 

3. You can determine what tags are required on a display by using a few keyboard shortcuts.  

Press CTRL + A  to select all components on the display. Press Ctrl + R  to open the Tag 
Substitution  dialog:  
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The Tag Substitution dialog is primarily used to make substitutions for tag references on a display. 
We are using it here because it shows all tags referenced in the display. Look at the tags listed in the 
Search for  list, and note that two tag placeholders (#1 and #2) are referenced. This means that the 
display is expecting to get at least two tag placeholders passed to it when it is opened. 

4. Click Close  to close the tag Substitution dialog.  

5. The Logix_PIDE_AutoTune display is opened from a Goto Display button on the Logix_PIDE_Trend  
display. This display is again generated from a Global Object, so double-click on Logix_PIDE_Trend  
under Global Objects  in the application Explorer:  

 

The Logix_PIDE_Trend global object display is opened:  
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6. Right-click on the Global Object display and select Object Explorer . 

 

7. The View Studio Object Explorer is opened. Find and double-click AutoTune_GotoDisplayButton  to 
open the Properties dialog for that object.  
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8. Note that the Parameter list includes tag placeholders #1 and #2: 

 

These are the tag placeholders required by the AutoTune display, so this Goto Display button is 
configured properly. Click Cancel  to close the Properties dialog.  

9. The Logix_PIDE_Trend display is opened from a Goto Display button on the Logix_PIDE display. 
Again the Logix_PIDE is generated from a Global Object, so double-click on Logix_PIDE  under 
Global Objects  in the application Explorer.  

 

10. When the global object display opens, right-click on it and select Object Explorer  (if it is not already 
open). Double-click on the Trend_GotoDisplayButton  object in the Object Explorer to open the 
Properties dialog for the button.  
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11. Note that the Parameter list again has two tag placeholders, #1 and #2. Again, this is what is required 
for the secondary displays, so click Cancel  to close the Properties dialog.  

 

12. Finally, the Logix_PIDE  display is opened from a Goto Display button on the 12 What is new  
display. Double-click 12 What is new  under Displays in the application Explorer to open it.  

 

13. On the 12 What is new  display, double-click the Process faceplates with Carry Forward 
Parameters  Goto Display button to open its Properties dialog.  
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14. The property we are interested in is the Parameter list. The property value is too long to see in the 
space provided, so click in the box to place the cursor there and use the right arrow key to scroll. 
Note that there is only one tag in the list!  

 

The first tag in a parameter list will populate the #1 tag placeholder in a secondary display, the 
second the #2 tag, and so on. Although the Logix_PIDE and Logix_PIDE_Trend displays do not 
require a second placeholder tag, Logix_PIDE_AutoTune references placeholder #2. Therefore this 
placeholder must be defined in the “base” display, the display that initializes the passing of 
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parameters. To fix the errors you were seeing from the AutoTune display, you must add a tag 
reference that will be passed through as the #2 tag placeholder. 

15. Place the cursor at the end of the Parameter list  property, then click the browse  button to select a 
tag to pass through to the #2 tag placeholder. Browse to and select the online tag PIDE01_Tune  in 
Program:Fermenter_Temp . (The tag is here: InstantFizz Advanced -> PLC1 -> Online -> Program: 
Fermenter_Temp -> PIDE01_Tune.)  

Click OK to add the structure tag to the Parameter list.  

 

Click OK to close the Goto button properties dialog.  

16. Close all open displays and global object displays. Save your changes if you are prompted to do so. 

Testing the Application 

1. Click Test Application  on the Application  menu. 

Make sure English  is selected as the only language in the run time application, and English  is 
selected as the initial run time language. Click Finish  to compile and start the project. 

When the project starts, click the Process Faceplates with Carry Forward Parameters  button on 
the initial display.  
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2. Now navigate through the nested displays to the Logix_PIDE_AutoTune  display. On the 
Tank_PIDE01 display, click the Trend  button to open the Trend display: 

 

Note that there are no errors when opening the Trend display. 

3. On the Trend display, click the AutoTune  button to open the AutoTune display: 

 

The display should open with no errors! Your troubleshooting was successful. Feel free to navigate 
through other displays.  

Click the Shutdown Demo  button to stop the test application:  

 

Congratulations!!   You have successfully explored the use of parameter files and learned how to carry 
tags forward using this functionality. 
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Logging data (20 minutes) 

Completing this section requires approximately 20 minutes. 

A commonly required feature in FactoryTalk View ME is the storage of application data. FactoryTalk View 
ME provides two choices for storing data, the Data Model and the DataStorePlus ActiveX control. The 
following table highlights the differences between the two:  

Data Model DataStorePlus ActiveX control 

Native/built-in control Add-on feature 

Timed, data change, data % change triggers Timed or tag trigger logging 

Always active/running Can control logging (on/off) 

Only 1 data log model supported at run time Multiple data log support 

 1 file only, first in-first out after maximum 
data points 

Multiple file support 

300,000 data point maximum Only storage limit to data points 

Binary proprietary file Plain text .CSV file 

Works with Trend display to show historical 
data 

Does not work with trends 

Supported in all PVP terminals Requires PVP CE (700-1500), with exception of 
PVP v6.0 

Good for Trending historical data and native 
functionality. Easy setup. 

Excellent for plain text or high speed data archiving. 

In this section, you will: 

� Use the Data Model storage method to log product counts for the InstantFizz Advanced application 

� Configure the logging of data for every one second, add the required tags to the data log model and 
add it to the project startup properties. 

Open the InstantFizz Advanced application 

If you already have the InstantFizz Advanced application open from a previous section, you can move on 
to the next section, Creating the Data Log Model . 

1. To open FactoryTalk View Studio, click Start > All Programs > Rockwell Software > FactoryT alk 
View > FactoryTalk View Studio .  If FactoryTalk View Studio is already open, then select File > 
Open Application…  to switch applications. 
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2. Select the existing InstantFizz Advanced  application, make sure English  is selected for the 
Language , and click Open : 

 

3. If you are switching applications you will be prompted to close the currently open application, click the 
Yes button to proceed. 

 

Creating the Data Log Model 

1. Right-click the Data Log Models  option located in the Data Log  System container to open the dialog 
and select New. 
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Data Log Models allow for historical trending.  

Multiple Data Log Models can be defined at design time. 

Only 1 Data Log Model can be enabled at runtime. 

The model will not log data for string tags, array tags, parameters or expressions, and you cannot use tag 
placeholders in your data log model.  

The Data Log file is saved in a format designed for runtime performance and file size reduction. The file 
cannot be saved/exported to CSV or other file format at runtime. 

2. On the Setup  tab, type ‘Product Counts ’ in the Description  field and enter ‘3600’ in the Maximum 
data points  field.  

 

 

In this lab you will be logging 3 tags at a rate of 1 second, as a result a Maximum data points  setting 
of 3600 will allow us to log approximately 20 minutes of historical data. 3600 data points / 3 data 
points every second  = 1200 seconds = 20 minutes 

 

Note that the Description field is for your reference only and is not used by Machine Edition 

The Maximum data points are the total number of tag values to store. When this number is reached, the 
oldest tag values are deleted to make room for new values. The minimum is 100; the maximum is 300,000. 
The default is 1000. The higher you set the limit, the more space the data log file requires on the runtime 
computer, or, if you are logging to a custom path on a remote computer, on the remote computer. The data 
log file is created at startup of the application. 300,000 points will use approximately 4.7MB of space 
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3. Select the Paths  tab, here you can define where the Data Log is stored. Leave the path set to the 
default location. 

 

 

If logging to \Storage Card2\Logs and the CF card is removed Data Logging will stop.  

Once the data log starts it cannot be stopped during runtime by the operator  

Machine Edition does not support dynamic log file creation during runtime  

Best practices for a Panel View Plus 400-600 terminals is to data log to a external CF card or remotely  

If using a network location the network must have domain name resolution, such as a DNS server, to 
resolve the UNC computer name defined in your path, you cannot use the IP address of a network location. 

4. Select the Log Triggers tab; here you can define the method used to trigger the logging of data. Enter 
‘1’ in the Interval  field as shown below, leave the default at Seconds . 
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Periodic: 

Fastest log rate possibly is 100 ms however logging too fast can cause performance related issues, in most 
cases this rate is not feasible with a typical application due to other loads on communications. 

Best practice is logging at the slowest possible rate desired by the process being monitored. 

On Change: 

Use the On Change trigger to log tag values for any tag who’s value has changed by a certain 
percentage. A Change Percentage of 0 will log all changes for a tag. 

The Maximum update rate is used to specify the maximum rate at which data servers will send 
data to the tags in the data log model.  

The Change percentage is the percentage a tag value has to change in order to trigger logging. 
To log all changes, enter 0.  

Heartbeat 

Type a time and select a time unit to specify how often tag values are logged even if no change 
has occurred. The heartbeat is unique to each tag in the Data Log Model according to when the 
tag last changed value. 

5. Select the Tags in Model  tab, here you will define which tags will be included in the Data Log Model.  

 

Maximum number of tags allowed in a model is 100  

The model will not log data for string tags, array tags, parameters or expressions, and you cannot use tag 
placeholders in your data log model.  

Tags can be HMI or Direct Reference 

6. Click the Tag browse button  to open the tag browser. 
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7. Expand the PLC1 shortcut, expand the Online , then ProdCounts  folder.  Use the mouse + Ctrl key 
to select the Good, Scrap and Total  tags. 

 

8. Click Add Tags(s) to List  , the 3 tags will now appear in the Selected 
tag(s)  window as shown below. 

 

9. Click OK to close the tag browser dialog. 
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At this point all 3 tags have been selected but have not yet been added to the Data Log Model.  

 

10. Click Add    to add the 3 tags to the Data Log Model.  You should have 3 tags in the 
Data Log Model as shown below. 

 

11. Click Close   to save the Data Log Model changes. 
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12. Click Yes  when prompted to save changes. 

 

13. Enter ‘Product Counts ’ in the Component name  field when prompted. 

 

14. Click OK  to save the Data Log Model. 

Configure application to start the Data Log Model o n startup 

1. Double-click the Startup option located in the System container to open the dialog. 

  

2. Check the Data Logging  checkbox.  Since Product Counts  is the only data log configured, it is 
automatically selected. 
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3. Check the Initial graphic checkbox if it isn’t selected already and ensure that 1 Overview is selected 
as the Initial Graphic. 

 

4. Click OK  to save the Startup changes. 

Examine the Trend object properties 

1. Expand the Displays  folder in the Project Explorer window and double-click on 4A Labeling – 
Trend to open the graphic. 

2. Double-click on the Trend object to open the Trend Object Properties  dialog and select the 
Connections  tab. 

Here you will see that the same 3 tags that you selected for the Data Log Model in the previous 
section have been configured in the Trend. 

 

3. Select the Pens  tab.  The pens from the Connections tab have been linked in this list and there 
currently is no Data Log Model defined so you will only see real time data in the Trend object. The 
data will start trending when you open the graphic display and will restart every time you open the 
graphic display containing the Trend object. 
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4. Use the drop down menu to select the Product Counts data log model so that the Trend object will 
now display historical data. 
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Trend object doesn’t support dynamically making pens visible or invisible  

Note that each pen has a default color, these can be changed  

The default width of 1 should not be changed as performance issues can result 

Only one Data Log Model can be loaded and available at runtime 

The data log will read the data log model only once when opening a display with a trend object  

300,000 point data logs can take several seconds to load data and allow the operator to interact with the 
Trend object. This will occur each time a display is opened that is accessing the Data Log. 

4. Select the X-Axis  tab. 

Notice the default value of 2 in the Time Span field. Remember that the Data Log Model has been 
configured to log approximately 20 minutes of data so you will leave the default at 2 minutes to show 
some of the Data Logging capabilities within the timeframe of the lab. 

 

Setting the X-Axis time span too high (hours, days) will also leave a severe memory foot print . The trend 
display should never be left open if the X-Axis is configured for hours or days because the HMI will run out of 
available memory. 

5. Select the General  tab.  You will use the default Refresh Rate of 1 second.  
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Best practice is to set the Trend Refresh Rate no faster than the amount of time it takes to put a data point 
on a trend  

Formula:  Fastest Possible Refresh Rate = ( X-Axis Time (seconds) ) / (Width of Trend Object in pixels)  

6. Select the Display  tab.  Highlight the value of 200 in the Buffer for extra data  field and enter the 
value ‘0’. 
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Note that in this lab we are using a Data Log Model to buffer historical data so we do not need a buffer. If 
this was a real time trend with no Data Log model and we did not define any buffer you would not be able to 
scroll back in time and see historical data. Once you attempted to scroll back in time or ahead in time all 
data on the screen would be lost. 

Using a Data Log Model also allows for data to be seen immediately when the Trend display is opened, 
depending on how long the application has been running. Without a Data Log Model you will have to wait for 
real time data to fill the Trend display. If the X-Axis time span is a long time span you will have to wait that 
long to see how the data is trending. 

Trending memory is consumed over time and not allocated on startup of the application. 

Buffer extra data for Real Time Trending only. 

Max buffer size 32767 records. 

Buffering to much extra data will leave a severe memory foot print.  

If the application uses a data log you don’t need to buffer extra data (Data log becomes the buffer). 

The Trend object must be linked to the data log file for Historical Trending.  

7. Click OK  to the Trend Object Properties  dialog. 

8. Close the display and choose Yes when prompted to save changes. 

Testing the application 

1. Click Create Runtime Application  on the Application  menu to create the run time .MER file.  
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2. Make sure the file is named InstantFizz Advanced.mer  and the Runtime 6.0 application type is 
selected, then click Save. 

 

Click Yes if asked if you want to overwrite the existing file. Select English  as the initial runtime 
language and click Finish . 

The run time file is created. It will take a minute or two to compile the application and generate the 
.MER file. 

3. When it is finished, click the Transfer Utility  button on the FactoryTalk View Studio toolbar:  

 

4. Click the browse button for the Source file and select: C:\Documents and Settings\All 
Users\Documents\RSView Enterprise\ME\Runtime\Instan tFizz Advanced.mer . 

5. In the bottom pane, select your PanelView Plus terminal as the destination. The Transfer Utility 
should look something like this: 
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Your terminal may look slightly different – look for the PanelView Plus terminal with the IP address of 
192.168.1.20. 

6. Click Download  to download the project to the terminal. If you are asked if you want to overwrite the 
destination file, click Yes. You will see a progress bar, and when the download is complete a 
message box will tell you the download completed successfully. Click OK.  

7. Click Exit to close the Transfer Utility.  

8. Move over to your PanelView Plus terminal. If FTView ME Station  is not already running, start it by 

double-tapping the icon on the desktop:  

9. Tap Load Application [F1] . Select InstantFizz Advanced.mer  in the file list, then tap Load [F2] .  

10. Tap Yes to replace the communications setup. When the application is loaded successfully, you will 
see the file name in the Current application  box. Tap Run Application [F2]  to run your project.  

11. Take about 1 minute and navigate  throughout the application without  viewing the Trend display.  
This will allow some time for data to be stored in the data logs. 

12. Now, switch to the Trend display using the Trend  button  on the navigation bar across the 
bottom of your display. 

The data log model started running once the project had started.  Since we are using historical data 
from the data logs, this data is populated in the trend object every time you view this display. 

Congratulations!!! You have successfully created a data log model and used a trend object to view 
historical data. 
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Appendix A: Configuration/Setup Guide 

 

Lab 15 – NEW PanelView Plus 6 with NEW 

FactoryTalk View ME V6.0 and ViewPoint 
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Lab Setup and Configuration Information 

Lab Information 

    

Lab Name 
IA-11-L01 - NEW PanelView Plus 6 with NEW FactoryTalk View ME V6.0 and 
ViewPoint 

Lab Description 

This hands-on lab focuses on the NEW FactoryTalk View Machine Edition Version 
6.0 concepts for new users running on the NEW PanelView Plus 6 with embedded 
Microsoft CE. This lab includes creating an application, working with displays, 
global objects, and tags, using parameters and faceplates, as well as testing and 
running the application with language switching. FactoryTalk ViewPoint is also 
used to host a remote web-based connection to an application. Beginners or 
experienced users can explore new enhancements available in this lab. 

Lab Creator Lianne Chu 
Date Created 12/16/2010 
Updates:   

12/16/2010 Lianne Chu 

Hardware Configuration per Student 

Qty Demo Cat.# / Description Communication Location Firmware 

1 Computer workstation consisting of       

1 2 GHz CPU 

1 4 GB RAM 

1 Hard drive.  Minimum 40GB capacity 

1 USB Keyboard 

1 USB Mouse 

1 
Ethernet adapter.   Configured for 

DHCP 

1 

Ethernet adapter.   IP Address: 
192.168.1.1, 

Subnet: 
255.255.255.0 

1 
Video adapter.  Minimum resolution: 

1260 x 1024 pixels 

1 
LCD Display.  Minimum resolution: 

1260 x 1024 pixels 

1 
Ethernet CAT5E cross-over cable 5ft 

(used with PanelView Plus terminal) 

1 
Ethernet CAT5E cable 5ft (used with 

Event classroom network) 

1 
 

PanelView Plus 6 1000 IP Address: 
192.168.1.20, 

Subnet 
255.255.255.0 

Firmware revision 
must support 
ViewPoint 1.2 



 

249 of 254 
 

Computer/Host Settings 

 

Location Files 
Computer Name Varies by machine 
IP Address (NIC 1) DHCP – connected to Event classroom network 
IP Address (NIC 2) Host computer TCP/IP setting: DHCP 

VMware image TCP/IP setting:  
IP Addr: 192.168.1.1 
Subnet: 255.255.255.0 

Operating System Windows XP SP3 

Basic Setup Diagram 
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Application/Programming 

Location Files 

C:\Lab Files\ViewME – ViewPoint\PVP 

Copy all files to the root of a USB storage or SD 
memory card. Then insert into the PanelView Plus 6 
terminal to run the batch that will configure and copy 
all necessary lab files. 

C:\Lab Files\ViewME – ViewPoint\SoftLogix 

InstantFizz.acd (slot 2) 
ME_Intro.acd (slot 3) 
PVP6_Demo.acd (slot 5) 

C:\Lab Files\ViewME – ViewPoint\ViewME 

InstantFizz Advanced VP.APA 
PVP6_Demo.APA 
PVP6_Demo.MER 

C:\Lab Files\ViewME – 
ViewPoint\ViewME\Beginner 

Alarm Content for Tank2 and Tank3.xml 
Pump Content for Main Display.xml 

C:\Lab Files\ViewME – 
ViewPoint\ViewME\Complete ME Projects 

Complete_InstantFizz Advanced.APA (Chapter 3 and 
6) 
Complete_InstantFizz Advanced VP.APA (Chapter 4 
and 5) 
Complete_Chapter2_Complete.APA (Chapter 2 and 
6) 

C:\Lab Files\ViewME – 
ViewPoint\ViewME\Faceplates 

Copy all files to C:\Documents and Settings\All 
Users\Documents\RSView Enterprise\ME\Faceplates 
and overwrite the existing. 

C:\Lab Files\ViewME – 
ViewPoint\ViewME\Pick and Choose 

[L15 HISTORY] 640x480.gfx 
Flag_of_China.bmp 
Flag_of_Germany.bmp 
Flag_of_Spain.bmp 
Language Switch buttons (DEU and ZHN).xml 
Program Launcher.gfx 
Recipe_Tags.csv 
Soda Recipe.rpp 
TRANSLATED InstantFizz Advanced.xls 

C:\Lab Files\ViewME – 
ViewPoint\ViewME\Pick and Choose\ME 
Projects 

InstantFizz Advanced.APA 
Chapter2_Complete.APA 
 

Additional Equipment Required per Workstation 

Qty Items 
1 Ethernet CAT5E cross-over cable 5ft (used with PanelView Plus terminal) 
1 Ethernet CAT5E cable 5ft (used with Event classroom network) 
1 PanelView Plus 6 1000 
    

 

RSLinx - DDE/OPC Topic Configuration 

Topic Name Path to Hardware 
N/A 
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RSLinx - Driver Configuration 

Topic Name Path to Hardware 

AB_VBP-1 (no topic 
required) 

 

Slot 5, PVP6_Demo 

RSLinx Enterprise - Shortcut Configuration 

Shortcut Name Path to Hardware 

L15 
Ethernet, Ethernet > 192.168.1.1 > Backplane > 3, 1789-L60 v18 
Student configures this during Chapter 2. 

PLC1 Ethernet, Ethernet > 192.168.1.1 > Backplane > 2, 1789-L60 v18 
CLX Ethernet, Ethernet > 192.168.1.1 > Backplane > 5, 1789-L60 v18 

Application Versions 

Vendor Software Version Service Pack  

Rockwell FactoryTalk Activation Manager 3.30 CPR9 SR3 

Rockwell FactoryTalk Diagnostics 2.30.01 CPR9 SR3 

Rockwell FactoryTalk Service Platform 2.30.01 CPR9 SR3 

Rockwell FactoryTalk View Machine Edition  6.00.00 CPR9 SR3 

Rockwell FactoryTalk ViewPoint ME 1.20.25.0 CPR9 SR3 

Rockwell RSLinx Enterprise 5.30.00000 CPR9 SR3 

Rockwell RSLinx Classic 2.57.00.09 CPR9 SR3 

Rockwell RSLogix 5000 18.00.00 CPR9 SR2 

Rockwell SoftLogix 5800 18.00.00 
 

Rockwell Silverlight 3.0.50106.0 
 

Rockwell .NET Framework 
1.1, 2.0 SP2, 3.0 

SP2, 3.5 SP1  
Microsoft Internet Explorer 8   
Rockwell PanelView Plus 6 6.00.00  
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Required Pre-Lab Configuration 

Configure the Virtual Network 

Select Virtual Network Editor  from the Edit menu to open the Virtual Network Editor dialog. 

 

The dialog below will appear. 

 

Select the Host Virtual Network Mapping  tab 
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For VMnet0  select the physical ethernet adapter that will be connected to the PanelView Plus terminal. 

 

Click the OK button to commit the changes that have been made. 
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Additional Information 


